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�Faxmaker - an overview

Introduction

Congratulations with purchasing Faxmaker. Faxmaker will save your company time and money by offering you advanced network fax technology.

With Faxmaker, sending a fax is as easy as printing a document. Faxmaker integrates with most popular networks and applications.

This manual consists of two parts;

Installation and administration - Chapters until “Sending Faxes” - This part is meant for the network administrator,� XE "administrator" � and some knowledge of networking and computing is assumed.

Using Faxmaker - Chapters from “Sending Faxes” - This part is meant for the users of the system.

The Faxmaker system

The Faxmaker system consists of a Fax server program running on a fax server computer, and the client software programs, running on the users’ workstations. The fax server and the client software programs communicate with each other through a messaging system, and use a database, located on the file server to store information relevant to both the client software and the fax server.

The system is depicted in the following figures;

� EINBETTEN Visio.Drawing.3  ���

Figure 1 Faxmaker installation on a Windows NT� XE "Windows NT" � network

Figure 1 shows the Fax server running on a Windows NT server. The databases are stored on the NT server and the clients access the Faxmaker databases from their workstations.

This installation is very efficient, and does not require a dedicated workstation, whilst allowing you to expand to 32 fax lines per NT server. If you have purchased the 32 bit version it will also run as an NT service.� XE "NT service" �

� EINBETTEN Visio.Drawing.3  ���

Figure 2 Faxmaker installation on a Novell,� XE "Novell" � Banyan Vines� XE "Vines" � Network

Figure 2 shows the Fax server running on a workstation connected to a Novell Netware� XE "Netware" � file server. The databases are stored on the Netware server and the clients access the Faxmaker databases and fax files via the Novell File server. In this network a separate workstation is required to run the fax server. Depending on the volume of faxes sent, the computer hardware and the operating system, the administrator� XE "administrator" � must decide whether the workstation should be dedicated. The workstation can also be a windows NT workstation acting as an application server for Faxmaker and other programs.

Installation of Faxmaker on a peer to peer� XE "peer to peer" � network is similar to the installation in figure 1, except that the NT server is a normal workstation.

�Installation

Introduction

This chapter describes the installation of the software onto the file server, and the subsequent installation of the fax server and the administrator.� XE "administrator" � It will help you choose the installation options available, but will not discuss the various configuration options, which are explained per module in the following chapters.

Prior to running the installation procedure, you are advised to read the chapter “Faxmaker - an overview”.

� XE "Vines" �� XE "Netware" �� XE "Lan server" �Installing Faxmaker on a Netware, Lan server or Vines network

To install Faxmaker on a Novell� XE "Novell" � Network you must designate a PC to act as fax server, and run the installation from there. You must install Faxmaker software on the file server to a drive which can be accessed by all clients preferably using the same drive letters.

A depiction of the system can be found in figure 2 of the Chapter ‘Faxmaker - an overview’

� XE "Windows NT" �Installing Faxmaker on a Windows NT server network

On a windows NT network, Faxmaker can be installed on the file server itself, which means that the server will access the Faxmaker software and mailboxes using a path to the local hard disk of the server, usually C:

However the clients will not access the Faxmaker software using C: as the path name, rather they will use a network path such as F:, E: or K:

During installation Faxmaker needs to know both the path where to install the software (the path as the fax server will see it - the Server path) and the path as the clients will see it (The client path). Both paths can be edited after installation, but it is much easier to plan this out prior to installation, so that you can have the Faxmaker installation program do all the work for you! The installation will ask you to enter these two drive/paths.

It is also useful that all, or at least most of the clients see the drive where Faxmaker is installed with the same drive letter, for example k:. This greatly eases maintenance of the system. 

� XE "peer to peer" �Installing Faxmaker on a peer to peer network

On a peer to peer network, Faxmaker is installed on a workstation designated to be the fax server and possibly also the file server. This means that the Faxmaker server will access the Faxmaker software and mailboxes using a path to the local hard disk of the fax server, usually C:

However, the clients will not access the Faxmaker software using C: as the path name. Rather, they will use a network path such as F:, E: or K:

During installation, Faxmaker needs to know both the path where to install the software (the path as the fax server will see it - the Server path) and the path as the clients will see it (the client path). Both paths can be edited after installation, but it is much easier to plan this out prior to installation, so that you can have the Faxmaker installation program do all the work for you! The installation will ask you to enter these two drive/paths.

It is also useful that all, or at least most of the clients see the drive where Faxmaker is installed with the same drive letter, for example k:. This greatly eases maintenance of the system. 

Running the installation procedure

1. Insert disk 1 of the Faxmaker disk set in your diskette drive. Remember that you must run the installation program from the workstation designated to be the Fax server.

2. Run 'setup.exe' from the File Manager or choose 'Run' from the 'File' menu in Program Manager and type in <a:\setup.exe>.

3. The set-up procedure will now start, and you will be prompted by the installation routine whether you want to continue set-up. Click on the 'Continue' button.

�

The Language and Network choice dialog

4. A dialog will appear, asking you to select a particular network type. Select the appropriate network. For any version of Novell� XE "Novell" � Netware,� XE "Netware" � select Novell Netware (It does not matter whether you have version 2.2, 3.11, 3.12, 4.01, or 4.1). If your network is not listed, select another network in the list that is compatible to yours. Contact GFI Fax & Voice if in doubt. 

�

The installation path settings

5. The installation program will now ask you on which network drive and in which directory you want Faxmaker to be installed. You must select a network drive which is available to all Faxmaker users, and one which has sufficient space to hold not only the Faxmaker program files, but also the necessary fax files.  Faxmaker will need approx. 15 megabytes of free hard disc space.� XE "disc space" � In addition to this you must reserve approximately 5 Mbytes per user for fax files.

Depending on the network you selected you will also be asked to enter a path to the Faxmaker software as the client-workstations will see it. Refer to the first part of this chapter and to the Introduction chapter for more information on this.

6. The installation program will now copy all program files to the network drive.

After the software has been installed on the file server, the setup program will continue to install a windows program group with a fax server and administrator� XE "administrator" \r "D2HBadministrato8" � icons. After completing this, you must reboot windows, and run the Administrator program to add and configure the Faxmaker users. 

The Faxmaker setup program has now installed the necessary program files and created a directory structure on the network drive consisting of:

Faxmaker\client - This directory includes sub-directories with program files and client installation programs.

Faxmaker\system - This directory will include the Administrator and Server program files.

Faxmaker\mailbox� XE "Mailbox" \r "D2HBMailbox8" �� XE "Mailbox" � - This directory will include all user mailboxes and fax files. The Mailbox "default' will contain all incoming faxes. Faxmaker users who act as 'Inbound� XE "Inbound" �� XE "Inbound router dialog" �� XE "Inbound" �� XE "Inbound router dialog" � Router' will have access to this mailbox. (A Router is able to route� XE "Route" \r "D2HBRoute8" �� XE "Route" \r "D2HBRoute8" � incoming faxes to the designated recipient on the network.)

�

The Faxmaker program group

This directory structure has been purposely chosen to enable you to easily secure the program from unauthorised access to mailboxes using your network’s security features. See the “The administrator” Chapter, paragraph security, for more information on how to do this

� XE "OCR routing" �Installation of the OCR routing module



THIS SECTION IS ONLY APPLICABLE TO FAXMAKER USERS WHO HAVE PURCHASED THE OCR MODULE.

Faxmaker 5.0 users can opt to purchase an OCR module, that can automatically route incoming faxes to the right recipient. With this module, the fax server will scan the incoming fax for a recipient name, and if it finds a recipient's name, Faxmaker will automatically route that fax to the recipient's mailbox.

The module includes 1 OCR support disk, as well as a revised serial number. 

To install the module, run a:\setup.exe from the file run command in the Program manager menu. 

Follow the instructions explained during the installation. 

After installing the module, enter the new serial number in the registration dialog of the Mserver (See “Fax server” Chapter), or of the administrator.  You will now be able to setup OCR routing per user from the administrator, by going to the “routing tab” in the settings dialog.



�� XE "administrator" \r "D2HBadministrato11" �The administrator program

Introduction

The Administrator program allows you to setup and configure the settings of the Faxmaker users. The person who is authorised to supervise the system can add or delete Faxmaker users and administer their mailboxes. Mailboxes can be re-indexed and purged. To run the Administrator program you need to have administrator rights in Faxmaker. The program can be run from the Faxmaker\system directory, module name admin.exe.

�

The Faxmaker administrator

User administration

To setup Faxmaker you must create users for the system in the administrator. When you start the administrator for the first time, it will automatically assign administrator rights to the first user of the system. You can alter this later, but initially there has to be at least one administrator to setup/start the system.

Double-click the Administrator icon in the Faxmaker Administrator program group. The Administrator will now start.

The first time you start up the Administrator, you will be asked to confirm the creation of new system databases. Click on 'Yes'.

The program will now prompt you for a login name� XE "login name" \r "D2HBlogin_name11" � and a password.� XE "Password" �� XE "Password" � Since there are no users or administrators yet, it will create a user with administrator rights, and allow you to configure the program. You may change these default settings afterwards, but be sure to have at least one administrator! You are advised to use your network login name and password, so that you will not need to remember an additional password. 

You can now fill in your registration code,� XE "registration code" � as displayed on the registration card and/or diskettes, in the File menu of the administrator.

Creating users

All network users who want to use Faxmaker must be added in the Administrator program. The users, their full names and the path of their mailboxes are displayed in the main window of the Administrator.

1.  To add a new user select 'Add' from the 'User' menu. A dialog will pop up� XE "Pop up" � allowing you to enter a name for the user. If you have Novell� XE "Novell" \r "D2HBNovell12" � Netware� XE "Netware" � installed, you will be able to scan the bindery for new users by pressing the browse button. You are advised to use the actual network login name in order to avoid unnecessary duplication.

2.  Fill in a user name and click on 'OK'. You have now created a user in the Faxmaker system. The Administrator will automatically pop-up a tabbed dialog box which allows you to fill in user specific data and to configure the users’ settings.

�

The user settings tab

User settings

'Full name': You can enter the users’ full name here. This name will appear on the FAX header,� XE "FAX header" � if you select personal FAX header.

'Password': A password is required when using for the DOS� XE "DOS" �� XE "DOS" � client, as well as for starting the Administrator. Faxmaker will retrieve the Novell login name automatically under Windows 3.1, and will retrieve any network’s login name on Windows 95/NT. It is advisable to use the same password as used in the network.

'Billing code': The billing code is useful if you want to track a person's or a group's number of sent faxes. (For costing purposes, can be used in the call accounting module) 

Privileges:� XE "Privileges" � Here you can select each users’ privileges:

'Send with priority' - Selecting this option will mean that the Faxmaker Server will send the faxes of this user before sending the faxes of users who do not have priority.

'Access to default mailbox'� XE "Mailbox" �� XE "Mailbox" \r "D2HBMailbox11" � - Selecting this option will mean that this user will be allowed to route� XE "Route" \r "D2HBRoute13" �� XE "Route" \r "D2HBRoute11" � faxes which have been received in the inbound� XE "Inbound" \r "D2HBInbound13" �� XE "Inbound router dialog" \r "D2HBInbound13" �� XE "Inbound" \r "D2HBInbound11" �� XE "Inbound router dialog" \r "D2HBInbound11" � mailbox. Thus, he will have access to, and be able to view� XE "View" \r "D2HBView11" � all incoming faxes.

'System administration' - Selecting this option allows this user to start up the FAX Administrator program and maintain and manage the system. It also enables the user to open other users’ mailboxes.

Miscellaneous options;

Personal FAX header - activating this option will include the sender’s name on top of the FAX. This will allow recipients of the FAX to identify the sender. The users’ full name is used. 

Fax conversion� XE "Fax conversion" � on server - Faxmaker has been designed as a client server package, meaning that most of the processing of the faxes is done on the FAX server, including the conversion to FAX images. This requires a computer with 8 mb of ram and a 486 DX processor (Depending on the amount of users and volume of faxes). If you do not have this, you can deactivate the option for each user. 

� XE "voice mail" �Voice mail

The voice mail options are explained in greater detail in the “Using Voice Mail and Fax on Demand� XE "fax on demand" �” Chapter.

'Extension number': Should you have installed the Voice module then it is useful to indicate the person's extension number

‘Mailbox ID’ - To identify your mailbox remotely, you will need to enter an ID number here. 

'Pin Code' - You can enter a pin code� XE "PIN code" � here to protect your mailbox from unauthorised use.

Introduction to Routing

One of the most important features of today’s network fax packages is the provision of inbound routing of faxes. There are several ways to do this;

Manual routing - this involves designating a person to view all incoming faxes, and routing them to the recipient, based on the recipient name in the fax. This method works well but is labour intensive. The Fax manager� XE "Fax Manager" � includes a special inbound router dialog to route faxes quickly.

CSID� XE "CSID" \r "D2HBCSID14" � routing - this method can be a very functional and easy to setup way of routing faxes. It relies on the FAX ID which each FAX machine/FAX card displays when sending a FAX. Since it rarely changes, it can be used to identify the sender and thus the corresponding recipient. 

�

Routing a fax using the FAX ID (CSID)

DTMF routing - DTMF (Dual Tone Multi Frequency) tones are the tones generated by a telephone handset, and can be used to identify a recipient. The DTMF number can be appended after the regular fax number. The system works in the following way; The caller dials the fax number and waits until the call is answered. The fax card will now transmit a tone, after which the caller must enter the DTMF routing number. The Faxmaker server will recognise the DTMF number and use it to identify the recipient of the fax.

DTMF routing can work well, if you explain your callers how to use it. This can be done on the FAX cover of outgoing faxes. DTMF routing can also be used behind a PBX which supports DID. In this case you can use excess DID lines from the PBX to route the FAX to an extension.

�

Routing a fax using DTMF/DID routing

DID routing (Direct Inward Dial) - DID routing is generally considered the most reliable from of automatic inbound routing, because it relies on information provided by the telephone exchange, not on information provided by the caller. The system is completely transparent to the caller and does not require any effort on his part. DID can be used in conjunction with a PBX or hardware that recognises DID signals. Contact GFI or your dealer for installation advice.

OCR routing� XE "OCR routing" \r "D2HBOCR_routing15" � - Another easy way to route faxes automatically is using OCR. This system will OCR the first page of a fax, and consequently search the fax for a recipient name. If it finds one, it will route it to the recipients mailbox.� XE "Mailbox" \r "D2HBMailbox15" � This option requires the optional OCR module.

�

Routing a fax using OCR

Setup of routing per user

Per user you can setup one or more forms of routing. For example you can specify CSID and OCR routing, which together achieve a high percentage of successfully routed events. Note; All faxes which can not be routed will be routed into the default mailbox.� XE "default mailbox'" �

Per user you need to fill in the necessary data to route faxes automatically;

� XE "DID/DTMF" �DID/DTMF routing 

Fill in an appropriate routing code for this user. Remember that actual activation of DID or DTMF routing is done in the FAX server. The administrator� XE "administrator" � only stores the users’ routing code. The same routing  code can be used for both DID or DTMF routing.

CSID (Fax ID) routing

As explained the CSID routing system relies on the CSID of the incoming fax to determine the recipient. Based on this FAX ID, you can determine to which user the fax has to be routed. You can setup this option by clicking the CSID setup button. A list box will appear where you can add, delete or edit CSID numbers for this user. The numbers will be stored in the CSID database.

Automatic Updating

The CSID database is automatically updated by the inbound� XE "Inbound" �� XE "Inbound router dialog" �� XE "Inbound" �� XE "Inbound router dialog" � router. When an incoming fax is routed, the Fax ID is stored automatically so that the next fax can be routed by the fax server. The option can be activated or switched off from the inbound router dialog. For more information see the “Fax manager� XE "Fax Manager" �” Chapter.  

OCR routing

OCR routing requires the purchase of an additional module, the OCR engine. If you have not purchased the OCR module, you can configure it, but not activate it.

To setup OCR routing, click the OCR setup button in the Routing tab. This dialog has two tabs ;

1.  Greeting - meaning that the FAX server will search for a greeting such as Dear, Mr etc., before the actual user name. This means that the FAX server will only attempt to recognise a user name after it has recognised a  greeting word. You can add and remove greetings by clicking the add and remove buttons. You can enter a matching ratio, or confidence level in the edit box. This allows you to specify the confidence Faxmaker must have before it will actually recognise it as a greeting. Using this option you can tune the system to your specific needs. For normal use, a low setting is required, since greetings are short, and a lower matching ratio allows for OCR mistakes, and for 'spelling mistakes'.

2.  User keywords� XE "keywords" � - here you can enter keywords per user, which Faxmaker will search for to identify the recipient of a FAX is destined. If, for example, an individual Mr. Johnson, is also known as John, this keyword may be entered also, as well as Mr. Johnson. In addition, if Mr. Johnson is responsible for international sales, one might add international sales as a keyword too. A matching ratio can be entered to tune the system. 

� XE "Mail system" �Mail system

The mail system refers to the type of mailbox or e-mail system where incoming and outgoing mail should be routed to or logged in. By default Faxmaker will use its own mailbox system to store faxes and voice mail� XE "voice mail" � and notify users through its proprietary mailbox system. If you do not use Windows 95  - MS Exchange or use any other form of e-mail, this is your best option.

�

The mail system settings tab

If you use an e-mail system in your company, you may activate the radio box and add an additional mail system. Faxmaker supports MAPI e-mail systems, such as MS Exchange. This allows faxes to be logged in the Inbox of windows 95. If Faxmaker has to route� XE "Route" � a fax via an e-mail system, you must enter the user name in the e-mail system.

Faxmaker can notify users of successfully sent or failed faxes via your e-mail system. If necessary you can attach the fax file to the notification message. 

Messaging

The messaging dialog allows you to define when and how Faxmaker should notify the user of incoming faxes, successfully or failed faxes etc.

�

The message settings tab

Pop-ups

Pop-ups are message boxes which will alert the user. The following pop-ups can be activated.

Pop up� XE "Pop up" � message for incoming fax - activate a pop up message when a fax is received for the user.

Pop up a message after sending a fax successfully - activates a message when a fax has been transmitted successfully.

Pop up a message after a failed fax - activates a pop-up message when a fax has failed.

Pop-ups can be created using Windows NT� XE "Windows NT" � <NET SEND> messages (requires 32 bit server), or using Novell� XE "Novell" � Netware� XE "Netware" � <Send> messages. Windows NT <NET SEND> messages are only received if the client workstation is running the messenger service.  Caution - on Windows 95 and Windows NT workstations,  Netware messages will only work if you run Winpopup.exe� XE "Winpopup" � (Included on Windows 95 CD).

Call blocking

Call blocking allows you to exercise control over the fax numbers that the users can send to. To enable this option, activate the radio box. You can now add numbers to the list which may not be dialled by the user. Faxmaker will check the list before each fax transmission, and not send any faxes starting with numbers listed in the call blocking list. This means that if you want to disallow certain users making international fax transmissions, you only need to insert the international dial out number (for example 00, 09 or 011). Alternatively you can block specific fax-numbers. 



Managing the Mailboxes of each User

Each Faxmaker user has his own mailbox� XE "Mailbox" \r "D2HBMailbox19" �� XE "Mailbox" � in which he receives his faxes, and, if installed, voice mail.� XE "voice mail" � The path to the mailbox is displayed in the main window of the administrator� XE "administrator" \r "D2HBadministrato19" � application.

As the Faxmaker Supervisor, you can keep track of, and manage these mailboxes. You can purge and re-index mailbox - databases. You are advised to regularly check whether a mailbox is not taking up too much hard disk space.

The Mailbox menu

When activating these functions please make sure that no one else is using that mailbox at the same time!

'Purge deleted': This function allows you to remove the events, which users have read and deleted from the mailbox database. Each mailbox has its own database in which all events are stored. You are advised to purge the database regularly (+/- every month), in order to keep the mailbox databases compact.

'Re-index': Each mailbox database has an index. This index can from time to time become damaged. If so, you need to select the mailbox whose index you want to renew, and select re-index. 

� XE "Mailbox paths" �Mailbox paths

The main window displays two paths to the mailbox, one for the server and one for the client. Both paths are editable. This gives you a great deal of flexibility;

1. You can have different paths for the client and for the server. This means that the server and the client do not necessarily need to identify the drive of the mailbox as the same drive.

2. By having configurable mailbox paths, you can actually locate the mailboxes on different file servers, allowing you to serve a much greater number of users. 

When altering paths to mailboxes you must ensure that the new paths are correct, and that the settings in the ‘fmuser.ini’ and ‘fmprog.ini’ are still correct, otherwise there will be an error in the client or server application. See the “Advanced use” Chapter for more information.

Altering the server path 

Most of the times you will only need to alter the server path, since only the fax-server will have a different path to the mailboxes. To do this, all you need to do is change the first drive letter. You can do this by double-clicking on the server path cell, and entering the new drive letter.

Altering the client path

You will need to change the client path if you are planning to span mailboxes across multiple file servers. However besides altering the drive letter you will need to change various settings in the users’ configuration (INI) file. This INI file contains the users’ settings, as well as references to network phone-books, attachments� XE "attachments" �� XE "attachments" � and cover pages. Changing the client path in the administrator means you need to make this change in the user INI file too. This can be done via the option “Edit User INI file” in the User menu of the administrator. In this file (called ‘fmuser.ini’), you need to ensure that all entries are correct, i.e. that all paths to coverpages etc. are valid.

Besides editing the User INI file (‘fmuser.ini’), you might also need to alter the ‘fmprog.ini’ located in the windows directory of the users’ workstation. This is only necessary if you have already installed the client!. Again the drive letters in this file need to point to valid directories and databases.

Security

You can secure users' mailboxes from unauthorised access by setting security access in your network as follows;

All users: 

a.  Access to Faxmaker\client directory,

b.  Access to mailbox\<their user name> directory.

Default routers:

a.  Access to Faxmaker\client directory,

b.  Access to mailbox\<their user name> directory.

c.  Access to mailbox\default directory

Administrators and Servers:

a.  Access to entire Faxmaker directory.



�The Fax Server Program

Introduction

The Fax Server program is the core of Faxmaker. It is fully multitasking and will handle sending and receiving of faxes simultaneously. The Fax Server application shows general information on the ongoing processes in the ‘Info Bar’, located at the top of the main window. In addition to the info bar, there is a window for each fax line, displaying information such as; Current activity (idle, calling or sending), the fax number of the recipient or sender, the remote ID, the transmission speed (4800,9600 or 14,400 bps), the fax resolution, the page and the connect time.

�

The fax server main window

Configuring the Fax Server

When you start the Fax Server program for the first time, you must configure the 'Ports' that you will be using in the Fax server. A port� XE "port" \r "D2HBport21" � is a COM port with a modem attached. To open a port;

1.  Start up the Fax server.

2.  Select Open from the Port menu.

3.  Choose the appropriate Port (s)

4.  The server will automatically pop up� XE "Pop up" � the Modem and Fax Setup dialogs respectively

These dialogs allow you to configure modem & fax settings per port.

�

The modem setup dialog

Modem Setup

This dialog allows you to configure your modem. 

COM port -Select the appropriate port. You only need use this drop down box if you have several ports which you would like to configure at once.

Modem type - Select your modem from the drop down list box.

Initialisation string - Although the initialisation string does usually not need to be changed, you can edit the string in this field.

Incoming call detection� XE "Incoming call detection" � - By default the fax server will answer all incoming calls as fax only. However, if you have installed the voice mail� XE "voice mail" � or fax on demand� XE "fax on demand" � module (requires voice modem), you can have the fax server detect between fax/voice or voice only calls. This will allow callers to enter the voice tree structure. (See the “Voice mail” chapter in this manual for more information on the voice tree structure).

Speaker mode - Select whether you want the speaker to be 'Always Off', or 'On until connected' or 'Always On'.

Speaker volume - Select the appropriate volume. 

Action - Select whether you want this port to send, receive or both.

�

The fax setup window

Fax Setup

General options

Speed - Select the send & receive speed according to your modem's capabilities. Remember that not all modems are able to negotiate “down” well, so choose 9600 if in doubt.

'Fax ID'- Enter the fax ID which you wish to appear above each fax.

Send options

'Tone dialling' - Activate this check box if you can use tone dialling. If you deactivate it, the Fax server will use pulse dialling. Type in a 'Dial Prefix' if the Fax Server is connected behind a PBX.

'Wait for dial tone' - If you activate this option, the fax server will only send the fax if the modem detects a dial tone. Some export� XE "Export" �� XE "Export" � modems do not recognise the dial tone, so you must first test whether your modem recognises a dial tone.

'Check for busy tone' - Activate this option if you want the modem to check for a busy tone.

'Number of retries' - Sets the number of times Faxmaker will try to send a fax.

'Retry delay' - This option allows you to set a delay between retries in seconds.

 Receive options: 

'Answer incoming calls' - To have the fax server receive faxes, activate this check box. Specify after how many rings you want Faxmaker to answer in the 'Rings until answer field'.

�

The routing setup dialog

Routing

Inbound� XE "Inbound" �� XE "Inbound router dialog" �� XE "Inbound" \r "D2HBInbound19" �� XE "Inbound router dialog" \r "D2HBInbound19" � routing of faxes is set up in the Administrator,� XE "administrator" � however you must activate the various routing systems in the server in the routing dialog. Activate a routing method by clicking on the appropriate radio box.

�

The e-mail setup dialog

E Mail

If you wish to integrate with a MAPI e-mail system� XE "Mail system" �� XE "Route" � activate this option. You need to indicate the MAPI profile, which the fax server must use. (For more information see the chapter on e-mail)

If you wish to use a template for e-mail text, you can enter a template/CoverPage file name here. You can design a template or cover page� XE "cover page" \r "D2HBcover_page24" �� XE "cover page" \r "D2HBcover_page20" � in the Network cover page designer.

Printing

The printing options dialog allows you to configure automatic printing per port.� XE "port" \r "D2HBport24" � That is, you can select either the same or different printers to service the printing requests from various ports. Both incoming and outgoing faxes can be printed automatically.

Note: Because a fax is an image, printing a fax can take some time. The auto-print feature requires a faster PC, and printing must be set to low priority in the print manager if the printer is connected to the fax server directly. You are advised to print to a network printer.

� XE "Print redirection" �Print Redirection

The Print redirection feature (See chapter on print redirection), must be activated from this dialog. You can enter a print queue� XE "print queue" � to scan, and/or a directory to scan for PCL files.

In addition a template/cover page can be specified which is to be included with each fax.

Registration

The registration dialog allows you to change the serial number, and  thus to upgrade the program to more users, or add features such as automatic fax routing, fax on demand� XE "fax on demand" � and voice mail.� XE "voice mail" \r "D2HBvoice_mail25" � To read more about the upgrade options of Faxmaker, read the information file, called compan.wri, located in the Faxmaker program directory.

Voice setup

In this dialog the voice format for recording and play back of voice files can be entered. These settings do normally not need to be changed. Changing these settings will mean that you must re-record all system messages and voice mail.

Running the Fax Server Program

To run the Fax Server program, double-click on the Faxmaker 'Server' icon. 

If you want to run it automatically, you can install it in the 'Startup' group of Windows. Do this by dragging the Fax Server icon onto the 'Startup' group. The next time you start Windows, this program will start automatically. However if you want the Faxmaker server to open a particular port automatically, you must save the configuration as default first. This means that the Fax server will automatically open the ports and their configuration when the Fax server is started. To do this, Select 'Save configuration as Default" in the options menu of the server. The current 'configuration' will be stored and saved as default. To change the default configuration, simply change the current configuration and save as default again.

�Installing the Client software

Introduction 

After configuring the Administrator� XE "administrator" � and the Fax Server, you can start installing the Faxmaker client software onto the users’ workstations. 

For obvious reasons the installation program has to be run from the client PC itself. Most users will be able to install the client software themselves though. Faxmaker supports Windows 3.1, 3.11, Windows 95, Windows NT,� XE "Windows NT" \r "D2HBWindows_NT27" � DOS,� XE "DOS" �� XE "DOS" � OS/2� XE "OS/2" �� XE "OS/2" � and UNIX workstations.

Installing Windows 3.1 or 3.11 clients

1.  Run <setup.exe> located in the Faxmaker\client\install\win31 directory by using the 'Run' command from the 'File' menu in Program Manager.

2.  Follow the installation instructions displayed in the installation dialogs.

Running Faxmaker windows 3.1 clients on Novell� XE "Novell" \r "D2HBNovell27" � Netware� XE "Netware" \r "D2HBNetware27" � networks

On Novell netware networks, Faxmaker will automatically retrieve the users’ login name� XE "login name" � from Netware. In order for it to do this, you must have the Novell Netware windows client software installed (version 2.00 or above) and Netware shell 3.26 or higher installed. If you do not have these drivers, you may purchase them from your Novell dealer, or download them from Compuserve in the Novfiles forum. If you are experiencing trouble logging into Faxmaker from Novell, please read the following section

Troubleshooting Netware login problems

As standard Faxmaker will read the Novell login name automatically. However, on a few machines, this will not work because of driver incompatibility in Novell. Faxmaker will return the message; "Client software not installed properly". You can easily solve this by either disabling the option of checking for a login name, or by solving the incompatibility.

Solving incompatibilities;  

Faxmaker uses a Novell DLL called ‘nwcalls.dll’. Faxmaker supplies this DLL for your convenience, but because this DLL must coincide with your Netware windows client software (of which there are many versions), you may need to replace them by the ‘nwcalls.dll’, supplied by the Netware client software on your machine(s). This DLL may vary depending on which driver type you use (Netx, VLM or ODI drivers), and which version you are using.

If you are having trouble with Faxmaker’s version of ‘nwcalls.dll’, located in the Faxmaker\client\program directory you must replace it with the one supplied with your client software. If you install a later or earlier version of these DLL's be sure to remove the DLL from the Faxmaker Directory, or any other directory where it might be. This can be checked easily using the File Search command in the windows File Manager. 

If the workstations on your network use different versions of Netware client software, you must be sure that each of them uses the appropriate nwcalls.dll.� XE "‘nwcalls.dll’" � You can ensure this by deleting the DLL from the Faxmaker\client\program directory, and making sure that each workstation has its own nwcalls.dll in the windows directory.

Disabling Novell specific features

If you can not find the right nwcalls.dll for your network, you can turn off Faxmaker’s automatic log in. To do this, you must change the UseNetwareLogin setting in the [Misc] section of the fmprog.ini� XE "fmprog.ini’" � in the windows directory to 0. 

Installing Windows 95 clients

1.  Run <setup.exe> located in Faxmaker\client\install\win95 by using the 'Run' command from the 'File' menu in Program Manager.

2.  Follow the installation instructions displayed in the installation dialogs.

Under windows 95 and windows NT, there is no need to have the Novell Netware client installed and running.

Installing Windows NT clients

1.  Run <setup.exe> located in Faxmaker\client\install\winNT by using the 'Run' command from the 'File' menu in Program Manager.

2.  Follow the installation instructions displayed in the installation dialogs.

Under windows 95 and windows NT, there is no need to have the Novell Netware client installed and running.



Installing the windows NT fax printer driver.



After running the Faxmaker Windows NT Install program, you must install the fax printer driver from the Print Manager. 

To create a printer, you must be logged on as member of the Administrators, Server Operators, Print Operators, or Power Users group. 

Installing the printer driver and creating the printer

Use the Print Manager ‘Create Printer’ option from the Printer menu. 

1. Start the Print Manager from the Control Panel or Main group.

2. From the Printer menu, choose ‘Create Printer’.

3. In the Printer Name box, type <Faxmaker>.

�

The Windows NT create  printer dialog

4. Install the Faxmaker printer driver; In the Printer Properties dialog box, select ‘Other’ in the Driver box. 

5. In the Install Driver dialog box, specify the drive and path where the   faxmaker program\winnt directory is located, for example;

   k:\faxmaker\client\program\winnt and choose the OK button. 

6. In the Select Driver dialog box, select the Faxmaker driver. Then choose the OK button. 

7. The driver will now be installed by Faxmaker. 

8. In the Driver box, select the Faxmaker printer driver ‘Faxmaker’. 

9. In the Print To box, Select the ‘GFI’. (This port� XE "port" � should have been automatically added after you rebooted the system. If not, select other, and doubleclick on GFI Monitor to add GFI to your available ports.)

10. In the Create Printer� XE "Create Printer’" � dialog box, choose the OK button. 

11. This completes a basic printer installation. Once a driver is installed, Print Manager automatically displays a dialog box allowing you to set up the features of your printer. There is no need to change any of these options. 

� XE "OS/2" �� XE "DOS" �� XE "DOS" �Installing DOS / OS/2 clients

Faxmaker includes a full DOS client, which is comparable in operation to the windows version. Both fax files and phonebooks are interchangeable between the DOS and the windows version.

1.  In DOS, run <install.exe> located in Faxmaker\client\install\dos directory.

2.  Follow the instructions during installation.

3.  To run Faxmaker you must have Share installed and use a SET variable to let Faxmaker know where to find your personal settings file. The installation program will edit your autoexec automatically and add this. Therefore you need to reboot your PC after the installation!

After running the installation program, your program will have been installed correctly. To send faxes with the DOS client, you can use one of two options;

1. To fax directly from an application use the embedded codes� XE "embedded codes" � in the document, and print to the Faxmaker print queue.� XE "print queue" � Refer to the chapter on Print Redirection� XE "Print redirection" � how to install and configure this feature.

2. Use the TSR ‘PCLTAKER.EXE’. This is a two step process which involves running the TSR first. You may load this TSR program automatically each time the computer starts by adding the command ‘pcltaker’ to the ‘autoexec.bat’. PCLTAKER will capture printing from an application into a PCL file stored in a TEMP directory (configurable from the faxmaker.ini). PCLTAKER can be toggled on or off, so that users can print to fax or to the printer without loading or unloading the TSR.

3. To fax the file, the user must run the DOS client, after which faxes can now be sent similar to sending a fax from windows. 

Considerations when installing the DOS client;

Faxmaker needs to know the location of the personal settings file, before starting the client. This is achieved by using a SET variable. If for some reason the installation was not successful in configuring this automatically, you need to enter the following command;

SET FAXMAKERINI=f:\dosfax\faxmaker.ini

Substitute f:\dosfax for the path to the faxmaker.ini file.

In addition you need to load Share.exe before running the DOS client!

IMPORTANT!

To run the DOS client you need to have an expanded memory manager installed, such as emm386.exe or Qemm, and at least 540 k of free conventional memory.

�� XE "Print redirection" \r "D2HBPrint_redire33" �Print Redirection

Introduction

Print redirection allows DOS,� XE "DOS" �� XE "DOS" � Windows, UNIX and Mac workstations to send out faxes by printing directly to a network's print queue.� XE "print queue" \r "D2HBprint_queue33" � This allows faxes to be sent directly from the application, without the need to exit the application. In addition, the fax conversion� XE "Fax conversion" � is performed at the server end, which means that the workstations can continue their work almost immediately. After successful transmission, users can be notified via a network message. (See 'Messaging' in the administrator� XE "administrator" \r "D2HBadministrato33" � chapter). Documents are printed to the print queue using an HP Laserjet print-driver, as supplied with the application that is printed from. Under MS windows, you need to use the HP hppcl5e driver. This driver is available from HP and is usually supplied with HP printers. Alternatively you may download these drivers from GFI’s Compuserve section or Internet FTP space. Contact GFI for more information on this. Naturally, a fax number needs to be inserted in the document, so that the fax server knows where to send the document. To insert a fax number in the document, the user must enter the fax number at the top of the document, embedded between the following characters. @$<fax number>$.

For example;

@$00,356-661072$

This powerful feature can be relatively easily set-up, however it does require a basic knowledge of the network you are deploying. Therefore setting up this feature is best left to the network administrator.

Installing the print redirection 

Installing the print redirection feature involves the following steps:

1.  Creating a print queue on the network which the Faxmaker Server will scan for print/ fax jobs.

2.  Selecting that print queue in the Faxmaker server.

3.  Connecting the users to that print queue, by editing the system log-in scripts. 

4. Grant the user  running the Fax server program Queue operator and Queue server rights to  the queue Q_FAX. (Print queue administrator rights in Novell� XE "Novell" \r "D2HBNovell34" �). To do this, use Novell’s Pconsole.� XE "Pconsole" \r "D2HBPconsole34" � For further information on Pconsole please consult its manual. 

Creating the Print queue

At the time of writing, print queue support is only available for Novell Netware.� XE "Netware" � Support for more networks is being added continuously. Please consult your distributor or GFI for latest list.

In Novell Netware;

1.  Start-up 'PCONSOLE' - this program allows you to create and manage print queues and print queue users. Please refer to your network documentation for more information on PCONSOLE.

2.  Create a print queue called, Q_FAX. (Do NOT change the name) To do this, press enter on 'Print queue information’ in the main menu. A list of available print queues appears. Add Print Queue ‘Fax’ by pressing the 'Insert' key, and typing 'Q_FAX'

3.  The print queue is added to the list of print queues. You will now need to configure the Print Queue by highlighting 'Q_FAX', and pressing enter. A dialog box called Print queue information appears;

a.  Select option 'Current queue status'. Make sure the three options at the bottom are all set to yes.

b.  Select option 'Queue Users' - Please enter the users who may use the print queue. Make sure that the users you add are also Faxmaker users. In many networks, you can simply add the group Everyone, to enable all users to use the queue. 

3.  The Print queue has now been created and set-up. The Fax server now needs to be told which print queue to scan for print/fax jobs

Setting up the Fax server to scan the print queue

1.  Start the Server, and select the Printer redirection option from the Options menu. The Printer redirection dialog appears. The first option, 'Scan print queue' allows you to enter the name of the print queue you have created. Enter 'Q_FAX'.

2.  Click OK when you are ready. Remember that the Fax server must be logged in as a user with Queue operator and Queue server rights, to be able to service print/fax jobs on the 'Q_FAX' print queue.

In addition to a print queue, you may configure the Fax server to scan a directory for files to convert and fax out. The files which are placed in the directory must end with the file extension '*.pcl'.

�

The print redirection� XE "Print redirection" � dialog

Activating the option 'By default in high resolution' means that all faxes in the print queue will be sent out in high resolution mode.

In addition you can specify a cover page� XE "cover page" � which is to be used for each fax. A scan time can be entered to specify at which interval the queue must be scanned.

Configuring the users' workstations

Faxmaker is now ready to scan and send out print jobs via fax. Now, the users will have to be able to print to the new 'Q_FAX' print queue. In Novell this is achieved through the Capture utility (DOS� XE "DOS" � and Windows 3.1 users only). A brief overview of using the capture utility is given. For more information refer to your network's documentation. On the users’ workstation, an unused LPT port� XE "port" � has to be chosen, for example LPT3. 

Then at the workstation's command line type;

Capture LPT3 /Queue=Q_FAX

This will cause all print jobs sent to LPT3 to be routed to the print queue Q_FAX, after which the Faxmaker Fax server will send out the job as a fax. To complete the workstation's configuration, you must install a printer driver which prints to the LPT3 port. The printer driver has to be one that is suitable for an HP Laserjet III or higher, since Faxmaker attempts to convert PCL 5 files, the native printer language of HP printers.

To further refine the configuration, a macro can be created which allows the user to toggle between the fax and the printer.

�E Mail gateway setup

Introduction

Faxmaker integrates with MAPI compatible e-mail systems. It acts as a fax gateway� XE "fax gateway" \r "D2HBfax_gateway37" � to the e-mail users, and allows faxes to be sent from and received in the e-mail package.  Faxmaker supports all MAPI 1.0 compatible e-mail systems, such as MS Mail, MS Echange, Novell� XE "Novell" � Groupwise, Lotus CC Mail and Lotus Notes. More and more e-mail packages are launching a MAPI compatible e-mail driver, so please contact GFI for the latest list of compatible systems.

System architecture

The Faxmaker server acts as a gateway to the e-mail system� XE "Mail system" \r "D2HBMail_system37" � using a mailbox� XE "Mailbox" \r "D2HBMailbox37" �� XE "Mailbox" � on the e-mail system itself, called Faxserver.

All faxes which are to be sent by the Faxserver, and all incoming faxes which are to be routed via the e-mail system are sent from the Faxserver mailbox/user account.

In actual fact, the Faxserver is a user on the system which sends and receives mail just like other users. In order for the e-mail gateway to function, a MAPI 1.0 compatible client (such as MS Exchange), must be installed on the fax server. Furthermore a user ‘Faxserver’ must be created, and a profile with which the fax server can login automatically each time it has to route� XE "Route" �� XE "Route" � or send a fax.

Gateway setup

To setup the Faxmaker e-mail gateway, you need to ensure the following; 

1. Ensure that your e-mail system is correctly setup and working properly. There is no need to setup a new post office� XE "Post office" \r "D2HBPost_office37" � or gateway in the e-mail system.

2. Install an e-mail client on the Fax server computer. Create a user called Faxserver. Test whether the user can send and receive e-mail.

3. Create a profile for the Faxserver in which you have specified post office location etc. The installation procedure may vary per e-mail system.

4. Activate the e-mail option in the Fax server in the e-mail system dialog. If you have named your profile other then ‘Faxserver’, you need to alter the name here too.

Installation on MS Mail/MS Exchange

Windows 95 includes a client for MS Mail, called MS Exchange, which can be used to receive and send faxes with Faxmaker. Windows NT� XE "Windows NT" � & Windows 3.1 require separate versions of MS Exchange to be installed. For more information on this contact Microsoft or GFI. In windows 95; 

1. Start up the Control Panel applet in windows 95. In the control panel of windows 95 two applets are relevant to the Fax gateway setup;

a. Microsoft Mail Post office, used to create and administer users on the MS Mail system.

b. Mail and Fax, used to setup profiles per user, containing personal options and login names.

�

Windows 95 control panel

Creating a Fax server user

1. Double-click the Microsoft Mail Post office icon. The Post office “Wizard” will start and prompt you whether you want to create or administer a post office. If you already have your system installed and running, select administer, otherwise create a new post office (available to all users). Be sure that you have rights to administer the post office!

2. You will be asked for a post office location. Click browse if you are not sure where it is. A post office directory is usually called similar to ‘G:\WGPO0001’. Click ‘next’ after entering the location.

3. You will now be prompted for a mailbox� XE "Mailbox" � name and a password.� XE "Password" �� XE "Password" � In most systems, the mailbox name is the same as the user name. 

4. If you have correctly entered the name and password, the Post Office Manager will now start up. The Post Office manager lists all users in the system and allows you to add and remove users.

5. Click the Add User button. The Add User dialog will appear. Enter the name ‘FAXSERVER’ for both mailbox and name. Optionally you may enter a password. If you enter a password, remember that the fax server will not be able to load automatically, because it will prompt you to enter a password!

6. Click Close when ready. You have successfully created a Faxserver user.

Creating a Faxserver profile

After creating the Faxserver user, you need to create a profile for the Faxserver user. A profile is a set of configuration options used by Microsoft Exchange and other messaging applications that contains essential information, such as which information services you are using. This information includes the location of your Inbox, Outbox, address lists, and the personal folder files available to the Faxserver for storing and retrieving messages and files.

To create a Faxserver profile;

1. Double-click the ‘Mail and Fax’ icon.  If you have not created any profile yet on the computer, it will start up the Inbox Setup “Wizard”. If you already have a profile, The ‘Microsoft Exchange Settings’ properties dialog pops up, showing the properties of the active profile. In this case, you need to select ‘Show profiles’, and click Add, after which the Inbox Setup “Wizard” will start.

�

The profile list dialog

2. The Inbox Setup “Wizard” will ask you which information services you wish to setup. Select MS Mail only and click Next. If you have MS At work Fax installed, remove it.

3. Name the profile ‘Faxserver’. If you already have a profile installed, the wizard will prompt you for a profile name. Otherwise continue and rename profile to Faxserver afterwards, using the Copy Profile command.

4. The Inbox Setup “Wizard” will now ask you for the post office� XE "Post office" � location. Enter the post office location as you did when creating the Faxserver user.

�

The inbox setup wizard

5. The Inbox Setup “Wizard” will ask you for a user name. Select Faxserver. If you entered a password when setting up the FAXSERVER user, you will need to enter it here.

6. The Inbox Setup “Wizard” will now ask you for a path and a file name for the personal address book. Confirm the default suggestion.

7. The Inbox Setup “Wizard” will now ask you for a path and a file name for the personal information store. Enter a destination and file name. 

8. Click Finish. The profile has now been setup. If you named the profile anything else then ‘FAXSERVER’ remember to change the setting in the e-mail system� XE "Mail system" \r "D2HBMail_system40" � dialog in the setup menu of the fax server.

Activating the e-mail system

After setting up the e-mail system, you must activate the e-mail system in the server. This can be done in the setup menu of the fax server.

For e-mail messages which are to be sent via the fax gateway,� XE "fax gateway" � you can specify a template/cover page� XE "cover page" � in which the e-mail body text will be inserted. More information on designing a cover page/template can be found in the chapter “The network cover page designer”

E-mail options can be set per user in the Administrator.� XE "administrator" �

Setting Poll time in MS Exchange

By default the MS Exchange “poll time” (the interval in minutes that it checks for new mail) is 10 minutes. This means that the fax server will receive notification of new faxes to be sent every 10 minutes. If you send out faxes regularly via MS Exchange it is better to decrease the interval to 1-5 minutes.

� 

The MS Mail delivery settings dialog

To do this, double-click the “Mail and Fax” icon, and select the fax server profile. Click on Properties, and select MS Mail.

Select Properties again, and click on the Delivery Tab.

Now change the setting in the “Check Mail every X minutes” to your preferred interval.

	



�Fax archiving

Introduction

Faxmaker for networks includes a Fax archiving utility, which creates archives, compresses fax files, and allows you to search for faxes. Archives can be stored in separate directories, so that backup to Tape, CD-R, or diskette is possible.

In addition to archiving the faxes, it also deletes the events from the Faxmaker databases, which allows you to clean up mailboxes and control disk space.

�

The Fax archiver

Using the Fax archiver

� XE "Archive" \r "D2HBArchive43" �� XE "Archive" \r "D2HBArchive37" �Creating an archive

Start up the Archiver by double-clicking the Archive icon in the Fax server program group. 

1. From the File menu select New, and enter a name for the archive. Select an empty directory to store the archive file. This directory is used to copy all archived faxes too, so that you can easily back them up to another disk medium.

2. After creating an archive, you must set the options for archiving faxes. This is done in the Archive, Options dialog in the Archive menu

�

Archive Options dialog

Select the events you wish to archive. (For example, all incoming events older than 3 weeks). Activate the ‘Delete archived faxes’ option.

3. Click OK. The archive options have been set.

4. To add the faxes to the archive, select Add from the Archive menu. The archiver will start searching through all the mailboxes for faxes to archive, compress them, copy them to the archiver directory, and delete the fax and event from the mailbox.� XE "Mailbox" �� XE "Mailbox" �

Searching the archive

To search for faxes in the archive, select Search from the Archive menu. The search window allows you to filter faxes from certain senders, Fax IDs or dates.

�

The search options dialog.

For example, to search for faxes from the USA, which arrived in March or February of 1995, search as follows;

Enter the dates in the search window. From 1/2/95 to 1/4/95.

Now enter a number in the Fax ID. Since most faxes from the USA will use a 1 in their fax ID, enter 1.

Click OK to filter. The archiver will now filter all faxes which we’re received in March and February from the USA. (Providing their fax ID started with a one.) If you can not find the fax, you will need to cancel search and enter different criteria, for example, try +1 as the starting Fax ID, or enter the area code of the sender as the starting Fax ID. Finally, you can narrow down the search using the number of pages also.

Browsing through the Archive

After entering a search mask, a list of faxes will appear in the main window. From, To, Date and Time fields are displayed in the main window. 

By clicking on a fax, further details on the fax can be viewed on the right hand side of the window (including the file name). Double-clicking the event will load a miniature view� XE "View" \r "D2HBView38" � of the fax in the Preview� XE "Preview" �� XE "Preview" � area on the right hand side of the window. If you have archived the fax file to tape, there will be no preview of the fax.

Retrieving a fax.

For disk space reasons, you can store all ‘*.fax’ files in the archive directory on a Tape or CD - R, whilst keeping the archive databases (*.arc) on a hard disk for fast access. Using the search command you can retrieve the correct file names of the faxes you wish to view, after which you can retrieve that fax file from the tape or CD-R you stored it on.

After finding the correct fax file, you can use the viewer to view/print the fax.



�Call accounting

Introduction

The call accounting application allows you to analyse your fax costs by apportioning the cost of each call to specific users or departments. Phone call costs are also split up by destination.

This application is supplied free of charge after registering Faxmaker for Networks.

�

The call accounting application.

Installing the Call accounting application

After registering Faxmaker for Networks with GFI, you will be mailed an installation diskette with the call accounting program. Insert the diskette in your floppy drive and run setup.exe from the File menu in the program manager.

Using the call accounting application

After installation, start the call accounting application by double-clicking its icon in the program group. Before using it you must setup the tariffs, country codes, as well as low and high tariff times.

To enter the tariffs, go to the tariffs windows from the options menu. A dialog will appear listing available country codes and allowing you to enter the appropriate costs.

The set up dialog, also located in the Options menu, allows you to enter the high and low cost times, as well as to specify an international dial out number. If your fax server is located behind a PBX, and uses a number to get an external line, it is very important that you fill in that number, since the call accounting application will not work correctly without it. After setting up these dialogs you can continue to import� XE "Import" � the Send log of the server. 

The Fax Server’s Send and or Receive logs,� XE "Logs" � are located in the faxmaker\system directory, called ‘rcvlog.txt’ and ‘sendlog.txt’. These two text files include the server’s activity log. 

To import the Send log;

1. Select Import log from the File menu. The menu expands to ‘New file’ or ‘Append to current file’. Since you do not yet have a database of calls, select ‘New file’.

2. You must now select the file to import. Go to the faxmaker\system directory and select ‘sendlog.txt’ as the file to import.

3. Since you have not created a call-database yet, you will be prompted for a database name. Type in <callacc.mdb>. A database is created in Microsoft Access format (accessible by all programs that can read MS Access files).

4. Click OK - all entries in the Send log file will be imported and displayed in the main window.

5. You can filter events using the filter menu

6. To analyse the total number of faxes sent, select Total calls from the Analyse menu.

7. To analyse the cost of the calls select phone costs from the analyse menu.

8. All analysis takes place on the fax - calls listed in the main window. If you wish to list the costs per user or per billing code, filter accordingly first.

9. You can print the analysis using the print button.

�Advanced Use

Introduction

The chapter on advanced use is meant for users of Faxmaker who wish to use tune their Faxmaker installation and get to know all its features.

Sending Faxes from MAC and UNIX workstations

Mac and UNIX workstations can send and receive faxes using either the print queue,� XE "print queue" \r "D2HBprint_queue49" � or an e-mail package which connects to the e-mail gateway on the server. Most supported e-mail systems have both a UNIX client and a MAC client.

To setup the print queue or the e-mail gateway, please refer to the appropriate chapters.

To view incoming faxes, you can use any TIFF-F file viewer. Please contact GFI for more information on MAC and UNIX fax viewers.

Application integration

Using the network print queue

Faxing via the print queue allows you to integrate your applications  with Faxmaker. Most database applications, such as accounts programs, contact management and stock management packages already have client details and their fax-numbers stored somewhere in the internal databases. One can avoid duplicating these fax numbers in other databases, simply by integrating with Faxmaker via the print queue.

To do this, simply create an additional field on the database forms which you wish to fax out, containing the fax number in the control codes (see ”Print redirection� XE "Print redirection" �” Chapter). Then include a fax option on the form, which toggles the printer to the appropriate port� XE "port" � temporarily and prints the form. This can be done in any database script language available today.  

Via MAPI e-mail.

Most Windows applications available today include a MAPI Send mail event. Using the programs script, one can add the fax number to the top line of the mail event, followed by name and company for the cover page.� XE "cover page" �� XE "cover page" � By sending the mail to the fax-server, the fax will be sent out automatically. Additionally, this mail can be routed to other users first, so that a fax can be approved or edited prior to sending it out.

Faxes sent by MAPI can be formatted using a template, which allows you to choose fonts, add logo etc. For more information see the “E-mail Gateway Setup” Chapter.

Faxmaker API’s (Application Programming interface).



If the above integration possibilities are not enough, there is a C/C++ or Visual Basic API available from GFI. There are four API’s;

1. The Database API� XE "The Database API" � - allows for full access to Faxmaker’s database, which allows you to retrieve faxes, user information, and post faxes to be sent. This API can be used for integration with Document imaging systems.

2. The Spooler API� XE "The Spooler API" � - allows for control of the server’s event scanning process. This API would be used to access proprietary e-mail, work-flow or groupware applications. 

3.  The Voice API� XE "The Voice API" � - allows for control of caller interaction. This is useful for custom voice and fax on demand� XE "fax on demand" � applications.

4. DDK - Driver development kit - allows for development of drivers for fax and voice hardware which is not supported by Faxmaker.



Faxmaker INI files.



Understanding the Faxmaker initialisation files (called INI files), will allow you understand and troubleshoot Faxmaker better.

The client software INI files.

The client software uses two INI files, ‘fmprog.ini’, located in the Windows directory, and ‘fmuser.ini‘,� XE "fmuser.ini’" � located in the users’ mailbox� XE "Mailbox" \r "D2HBMailbox50" � directory.� XE "Mailbox" \r "D2HBMailbox42" � 

Fmprog.ini� XE "fmprog.ini’" �

‘fmprog.ini’ is used to store the path to the Faxmaker program and database, and is stored in the windows directory, because the path to the Faxmaker programs can be machine-dependent in some networks.



[Directories]

Database=k:\faxmaker\client - points to user database

Program=k:\faxmaker\client\program - points to program directory

[General]

FaxName=

ClientName=fclien32.exe - specifies client

Tempdir=k:\faxmaker\client\temp - points to temp directory

[Misc]

Language=ENGLISH - specifies language

UseNetwareLogin=1 - specifies whether to use Netware� XE "Netware" � login

All that is needed to run the client application from the network is the ‘fmprog.ini’ file in the windows directory. In addition you need to verify the path-names if any problems arise.

Fmuser.ini

The ‘fmuser.ini’ is stored in the users’ mailbox directory, and contains user specific information, such as attachments,� XE "attachments" �� XE "attachments" � phone-books, cover pages etc. The ‘fmuser.ini’ can be edited from the administrator,� XE "administrator" � so that attachment, coverpage and phone-book lists can be maintained by the administrator remotely. 

Using windows Copy & Paste command, the administrator can also duplicate attachment lists easily across multiple users. To copy the list of network attachments simply select the section [NetworkAttachments] in the ‘source’ fmuser.ini, copy it to the clipboard, open the ‘destination’ fmuser.ini and replace the [NetworkAttachments] section using the paste command. 

The server software ini files

The mserver.ini� XE "The mserver.ini" �

PCL converter settings

The PCL converter converts PCL files to fax format, which is a relatively time consuming process. Depending on the fax server’s processor and memory, you may need to tune the settings of the PCL converter.

This can be done with the following options;

BufferSize=8192

TimeSlice=1000

Buffersize refers to the amount of kb which the converter will convert at one go. Increasing it will make it faster but requires more memory.

Timeslice refers to the interval at which it will control to the server/windows. Increasing the timeslice will make the PCL converter faster but less multitasking. 

 

�� XE "Coverpage Designer" �� XE "Coverpage Designer" �The Network CoverPage Designer

Introduction

With the Network CoverPage Designer, you can design cover pages, which can be used by all Faxmaker users. You can design your cover page� XE "cover page" \r "D2HBcover_page53" �� XE "cover page" \r "D2HBcover_page55" � to include your company logo, Sender and Recipient fields, message boxes and any bitmap images. You could also use or customise the existing templates included in the CoverPage Designer.

The Coverpage designer can also be used to design templates for outgoing e-mail messages. In this way a plain e-mail text message can be formatted before it is sent out by the fax server. 

Designing a Cover Page

Start up the Network cover page designer from the Faxmaker program group on the fax server, or run ‘cover.exe’ from the faxmaker\system directory. The Cover page designer will automatically create a new template. If you wish to use an existing template as a basis for your template, open it first.

To design a cover page;

1.  Set a standard font type for your coverpage.

a.  Choose 'Font' from the 'Options' menu. This function activates the 'Font' window. When you want all your texts to have the same style, it is easier to choose this function before inserting any fields because the CoverPage Designer, will automatically insert all text fields in that font. If, at a later stage you decide to change the font, select the fields you want to change (if you want to select more than one, hold down the 'Shift' key whilst clicking on the fields with your mouse button, or drag over the fields with the mouse whilst keeping the right mouse button pressed. If you want to select all fields, choose the 'Select All' function from the 'Edit' menu) and choose a new font type, size or style from the 'Font' window. 

�

Font window

b.  You can choose fonts for your text from the 'Font' list, whether you want bold, italic, etc., from the 'Style' list and the size from the 'Size' box. The display box shows the currently selected font, its style and size. When creating a template with special fonts, ensure that these fonts are installed on the server!

c.  Click on 'OK' after having made your selection.

3.  Set your grid� XE "grid" � values

a.  Choose 'Grid' from the 'Options' menu. This allows you to align the fields displayed on your page with precision. Whenever you drag a field to a new location and the grid is 'on', the field will spring to the nearest grid value.

�

Set Grid window

b.  This function activates the 'Set Grid' window. The values in this window represent pixels. When the grid settings are at the default settings '1' (for both width and height), the grid is 'off'. To set the grid to 'on' you must specify a higher pixel value than '1', for instance <3> for both height and width. 

c.  Click on 'OK' to register� XE "Register" �� XE "Register" � your choice in grid values. You can change these values at any time.

4.  Import� XE "Import" �� XE "Import" � your company logo to use as a header for your cover page.

A dimension of a fax page in pixels is approximately 1800(W) * 2200 (H). Before importing your logo or any other bitmap, go to the application in which it was made and save it with the right measurements.� \definition "'Insert Picture'" ��a.  Choose 'Insert Picture' from the 'Edit' menu. The 'Add Picture' dialog box is automatically activated.

b.  Select the appropriate drive and directory. Double - click on your  '*.bmp' file to insert it in your cover page.

c.  Your picture has now been inserted in the CoverPage Designer work space. To move the picture, select it with your mouse and without releasing the mouse button, drag it to its new location within the page.��5.  Insert Sender fields. 

a.  Choose the sub menu title 'Company' from 'Insert Sender fields' in the 'Edit' menu. 

A Sender field always contains two sub fields, the descriptive field, for instance 'Company' (which can be deleted or edited by using the Edit text function) and the field '<S_Company>' in which the actual company name is displayed when you send the CoverPage. The CoverPage Designer inserts these fields at a default location in your work space.

b.  To move the field, select it with your mouse and without releasing the mouse button, drag it to its new location within the page. To select more than one field at a time, hold down the 'Shift' key whilst selecting or choose the 'Select All' function from the 'Edit' menu. 

c.  Repeat this procedure for inserting the Sender fields 'Lastname', 'VoiceNumber' and 'FaxNumber'. (If you wish, you can insert all the fields displayed under the 'Insert Sender field' menu, but usually a few fields such as the name of your company, your name and fax and phone number will suffice for a standard cover page.)

6.  Insert Recipient fields.

Recipient fields will ultimately display information about your selected Recipient. You can check the actual content of these fields when you select 'Hold for preview'� XE "Preview" �� XE "Preview" � in the 'Send Fax' window. You can then view� XE "View" � the completed cover page in the Viewer.

To insert Recipient fields:

a.  Choose the sub menu title 'Lastname' from the 'Insert Recipient fields' in the 'Edit' menu.

A Recipient field, like a Sender field always contains two sub fields, the descriptive field (which can be deleted or edited by using the 'Edit text' function), for instance, the word '<Lastname>' and the field in which the actual surname of the selected Recipient from the Phonebook� XE "Phonebook" � will be automatically inserted, for instance, '<R_Lastname>'. 

b.  Repeat this procedure for inserting other Recipient fields of your choice.

7.  Insert a time and date field. 

As in Sender and Recipient fields, the left field is the descriptive field, (which can be deleted or edited by using the 'Edit text' function) whilst the right field will ultimately display the current date and time respectively. 

a.  Choose the 'Insert Time' and subsequently 'Insert Date' from the 'Edit' menu.

8.  Insert a message field. 

a.  Choose 'Insert Message',' Small, Medium or Large' (depending on how much text you want to insert) from the 'Edit' menu. When sending a cover page be sure to make the message field big enough to include all text typed in the cover page text box. Therefore if you use the cover page to write a lot of text into it, choose the Large message field and choose a small font (arial 9 or 10) This will give you approximately 25 lines of text.

b.  Select it and drag it to its new destination, below the Sender and Recipient fields you previously inserted.

10.  Add the finishing touches to this cover page template.

a.  Select the descriptive name of the Sender 'Lastname' field.

Whilst the field is still selected, choose the 'Edit text' function from the 'Edit' menu, or double-click on the field. This activates the 'Edit Text' window. Type in <From:> and click on 'OK' to display the new text in your work space.

Select the Sender descriptive field 'VoiceNumber' and edit this text to <Tel:>. Repeat this so that the descriptive Sender field 'FaxNumber' reads <Fax:>. Repeat this procedure for editing the descriptive Recipient 'Lastname' to <To> and Recipient 'FaxNumber' field to <Fax:>.

b.  Delete the Sender and Recipient descriptive fields 'Company'.

c.  Repeat this procedure for inserting another text field displaying your full name and positioning this below your signature. 

d.  You could also add a header reading 'Facsimile Cover Page'.

�

Cover page with inserted bitmap, Sender and Recipient fields

11.  You can now save this template. 

a.  Choose 'Save Template' from the 'File' menu. This activates the 'Save Template As' dialog box. All CoverPage template files, must carry the extension '*.tpl', and must be stored in the Faxmaker/client/coverpge directory. Otherwise the coverpages will not be accessible to all Faxmaker users and the fax server.

12.  Set this template as the default template.

a.  If this is the standard template which you want to use for most faxes, name the template “Default.tpl”.

13.  Exit the CoverPage Designer

a.  If you are satisfied with your cover page contents, choose 'Exit' from the 'File' menu.

�� XE "voice mail" \r "D2HBvoice_mail59" �� XE "fax on demand" \r "D2HBfax_on_deman59" �Using Voice Mail and Fax on Demand

Introduction

Note; This chapter is only applicable to users who purchased the add-on voice mail/fax on demand module. In addition, a supported voice modem is required.

You can think of a voice mail system� XE "Mail system" � as a group of answering machines. A voice mail system is designed to have multiple users each of whom have their own section where to record their voice mail greetings and store their voice mail messages. . To separate users and their messages, the concept of a mailbox� XE "Mailbox" \r "D2HBMailbox59" �� XE "Mailbox" \r "D2HBMailbox45" � has been devised. Each user has a personal mailbox, which is PIN code� XE "PIN code" \r "D2HBPIN_code59" � protected for security, where messages are recorded and stored. Faxmaker can act as a voice mail system for all Faxmaker users. This means that each Faxmaker user will be able to receive voice mail messages in his mailbox, in addition to fax messages. Voice mail can provide a back-up system for communication with clients or outside contacts, but can also provide a means of communication between colleagues and users.

In addition to voice mail, Faxmaker can also provide callers with 24 hr fax information. This technology is called Fax on Demand. Callers can call the system and request specific information, which is faxed back to them immediately.

Using Faxmaker's Voice Mail Feature

How do callers record voice mail for users?

Callers can record messages for users as soon as they enter the mailbox. First of all a greeting message will be played, after which the caller can record a message after the beep. After recording the message the caller can either hang up the line, or re - record the message.

How do callers select the desired mailbox?

By connecting the system to a PBX, the system can pick up the phone whenever it is not answered. The voice menu can then guide the caller to enter the desired users’ mailbox number, by listing the available users in the menu.

How do users listen to the messages that were left for them?

Users of a mailbox - or "Mailbox owners" in 'voice mail speak' - can access their mailbox in exactly the same way as a caller would, except that a mailbox owner will want to listen to messages or change the greeting. To do this, the mailbox owner must press # during the greeting. He will then be prompted to enter the correct PIN code, after which Faxmaker will present the mailbox owner with the mailbox owner menu. This menu plays the number of new voice mail messages and then allows the user to listen to voice mail, delete messages, or re-record a personal mailbox greeting. While listening to messages, a user can skip forwards and backwards through messages, as well as delete and repeat individual messages. Mailbox owners can set their pin code in the Faxmaker administrator.� XE "administrator" �

How do callers interact with the voice mail/fax on demand system?

When callers call the voice mail/fax on demand system, they are treated in a standard way by the system. In other words, they are guided through a fixed tree structure to be able to make use of certain functions. This tree structure is best explained by a graphical flow chart, as illustrated in the following figures. 

�

The voice tree structure with voice mail & mailbox owner options

�

The Fax on Demand tree structure

� XE "voice mail" \r "D2HBvoice_mail63" �� XE "Mailbox" �� XE "Fax Manager" �Viewing your mailbox with the Fax manager  and playing voice mail

Users are notified of new voice mail via the Fax manager. Start-up the Fax manager by double-clicking its icon in the Faxmaker program group. (More information on the Fax Manager is included in the next  chapters.)

Your mailbox will include mail with a small telephone icon next to it, signifying voice mail. You can delete your voice mail from here. To listen to your voice mail you must dial in to the voice mail system,� XE "Mail system" \r "D2HBMail_system63" � and play your voice mail messages. If you have listened to a voice mail you will notice that the voice mail will turn to 'read'. 

� XE "fax on demand" \r "D2HBfax_on_deman63" �Using Faxmaker's Fax on Demand feature

Fax on Demand technology allows you to provide 24 hr product, price or support information by fax. Faxmaker Corporate includes this functionality and allows you to define up to 100 documents for retrieval by fax. These documents can be created in any application using the Faxmaker printer driver. 

To use the fax on demand feature, you will have to store the fax on demand documents in a specific directory and use a particular naming convention. By default this directory is faxmaker\client\fax. All fax documents must be 'named after' the corresponding number, that the caller must enter to retrieve the document.

For example,  you want to include 9 documents with price and product information. To do this you must create your fax documents with the Faxmaker printer driver, and save them with the following file names;

1.fax, 2.fax, .... 9.fax etc.

When a caller enters the fax on demand menu, he will be offered a list of 9 choices, after which he selects one or more of the documents, for example option 2. 

Faxmaker will then scan the directory for the file 2.fax (matching the DTMF number), and send out the file by fax.

Faxmaker will always fax the fax file corresponding to the DTMF number the caller entered. One can define up to 100 faxes, by including 0.fax to 99.fax in the fax directory. 

Creating the fax documents for retrieval

Documents can be created using the Save as attachment/ Save as file feature located in the advanced dialog of the Sendfax window. For a description of the exact procedure please refer to the “Sending Faxes” Chapter.

Personalising the fax on demand menu prompt

The fax on demand menu prompt is played when a caller enters the fax on demand menu. One can of course use the default system prompt included with Faxmaker, but ideally you will personalise this prompt to explain the available fax documents to the caller

� XE "administrator" �Maintaining mailboxes and voice mail with the Faxmaker Administrator

The Faxmaker Administrator lets you delete voice mail and manage mailboxes. This allows you to quickly clean up your voice mail system and delete old voice mail messages. 

Advanced options

The fax on demand system includes some more advanced options and settings which you can use. To set these options you must open the ‘mserver.ini’ file, located in the faxmaker\system directory, and go to the [FaxOnDemand] section of the file. This section contains the following options;

HighRes=0. Change the value to 1 if you want all faxes to be sent out in high resolution.

CurrentConnection=0 Change the value to 1 if you want the faxes to be sent over the current connection; (i.e. the callers pays for the call), or 2 to let the caller choose.

Faxfile= <pathname> The pathname refers to the directory where all fax on demand documents should be stored.

MaxRepeats= <value> This value defines the maximum number of times the system will repeat a particular voice prompt without receiving a valid response from the caller.

MaxVoiceRecordingTime= <value> This value defines the maximum recording time of voice mail messages in seconds.

MaxCall Duration= <value> This option allows you to restrict callers to a maximum time limit.

MaxFaxDocs= <value> Maximum amount of documents which a caller can retrieve. (up to a limit of 8 documents)

Coverpage1= <filename> Allows you to define a cover page� XE "cover page" �� XE "cover page" � which will be attached in front of each fax request. Make sure that the file name is located in the fax files directory.

Coverpage2= <filename> Allows you to define a second cover page.

Blocked number1= <value> Allows you to block numbers starting with a particular value, for example 011, or 00. This can be used to disable all international numbers

Blocked number2= <value> Allows you to define a second blocked number.

Activating the Voice mail/FOD function

By default, Faxmaker Corporate will not activate the voice mail function. To activate it you must set the incoming call detection� XE "Incoming call detection" � in Faxmaker Corporate to fax/voice or voice only. To do this;

1.  Start up the Fax server

2.  Select the Modem set-up from the Options menu

3.  Set the Incoming Call Detection option to fax/voice or voice only.

4.  Click OK

Incoming calls, on that line, will now be routed into the voice/fod tree structure.

Recording Voice mail system prompts

In order to use the Faxmaker Voice mail system you must pre-record a number of system messages. (Instead, you may also use the provided system messages). This can be done with the Faxmaker Recorder.

A detailed description of each system prompt necessary, as well as the corresponding file name is given in the following table. All the following sound files are located in the default prompts directory (faxmaker\system\prompts, unless you changed it.). In addition you can use the system prompts supplied with the system, to save your configuration time. However, if you wish to personalise the system you will have to re-record all system messages with the Faxmaker recorder.

To start the Faxmaker recorder, run ‘frecord.exe’ located in the Faxmaker\client\program directory. Prior to running it, you must make sure that you have a COM port� XE "port" � free for using the recorder, and that you are recording from the Fax server computer. In the recorder you must indicate which prompt name you want to record by opening it with the 'Open' button, located at the top of the recorder.

To open the file: 'Enter your selection'. 

1.  Click on the 'Open' button. 

2.  Select 'retry.pcm' from the 'Open' dialog.

When you record a sound file, you must eliminate silence as much as possible, both before and after speaking. This ensures professional sounding texts.� \definition "Sound Recorder" ��The test box in the Sound Recorder now displays a suggested text for that system prompt.

3.   Click on the 'Record' button. This is the button with the red circle. Wait for the record button to turn bright red first!

4.  Record: <Please enter your selection>��You can now play back the file by clicking on the play icon. If you are satisfied with the recording, you can proceed to record the next file. All system messages, their default name and function are described in detail in the following table.

Voice mail prompts



System message�You are already on the first message.��Sound File name�VMFIRST.PCM��When used�This prompt is used when you select to hear the previous voice mail, but you are already at the first voice mail message. ��System message�Please leave your message after the beep and press the # key to stop recording.��Sound File name�VMGREET.PCM	��When used�This is the default greeting used to inform callers that they should leave a message after the beep. However, a user can easily create their own personalised greeting by choosing option 3 in the owner menu.��System message�Please enter the user number.��Sound File name�VMMBOX.PCM ��When used�This file asks for the user number, used for user identification. ��System message�New voice messages��Sound File name�VMNEWMSG.PCM��When used�This file is used to announce that there are new voice mail messages. Prior to this file the number of new voice mail messages will be played.��System message�There are no more voice messages.��Sound File name�VMNOMORE.PCM��When used�This file tells you there are no more voice mail messages to listen to. ��System message�The user entered does not exist. Please choose again��Sound File name�VMNOTUSR.PCM��When used�This file notifies the caller that he has selected a user that is not in the system. ��System message�You have.��Sound File name�VMNUMMSG.PCM��When used�This file is played prior to the number of messages that are waiting for you.��System message�Please press 1 to listen to your messages, 2 to delete them, 3 to record a new greeting, and 4 to leave the system��Sound File name�VMOWNER.PCM ��When used�Voice file explaining the options to the mailbox� XE "Mailbox" �� XE "Mailbox" � owner. Option 2 will delete all new voice mail messages. To delete individual messages, you must first listen to them.��System message�Enter your 4 digit PIN number now.��Sound File name�VMPIN.PCM��When used�This voice file asks you to enter your pin code.� XE "PIN code" ���System message�At any point press 1 to listen to the next message, 2 to repeat the current message, 3 to listen to the previous message, 4 to delete the current message, 5 to stop listening to your messages, or 0 to hear this prompt again.��Sound File name�VMREAD.PCM��When used�This file explains the options for listening to voice mail. Option 4 can be used to delete just the message you are listening to. To skip this prompt and start reading messages straight away, simply press 1.��System message�over 100��Sound File name�VM100MSG.PCM��When used�This file tells you, that you have over 100 messages waiting.��System message�You have entered an invalid PIN number; please re-enter it.��Sound File name�VMBADPIN.PCM��When used�This file warns that you have entered a wrong pin code number. A caller is given 3 chances to enter the correct PIN code before being disconnected��System message�Press 1 to save your message, 2 to play it, 3 to re-record it, and 4 to leave the system.��Sound File name�VMCONFRM.PCM��When used�This file explains the options for the caller who has just left a message. Option 1 saves the message and exits whereas option 4 exits without saving.��System message�The message has been deleted.��Sound File name�VMDELETD.PCM��When used�This file confirms that a message has been deleted.��System message�10 etc.��Sound File name�0-19.PCM��When used�For pronouncing numbers��System message�20 etc.  ��Sound File name�20.PCM, 30.PCM, ... , 90.PCM..��When used�For pronouncing larger numbers.��� XE "fax on demand" �Fax on Demand Prompts

System Message�Are you calling from a fax?��Sound File Name	�VERFAX.PCM��When used�When the system is set to 'Fax back on current connection' mode (CurrentConnection=1),  it must verify whether the caller is calling from a fax machine because if not, the fax transmission in this mode would not be possible. When the caller reacts positively, by for example pressing 1 on his telephone keypad, the system message 'Press start on your fax' will follow. If the caller reacts negatively, by for example pressing 2 on his telephone keypad, the transmission of documents in this mode is not be possible. The system will therefore bypass all other actions and hang up after playing back the 'Goodbye' system message. When the system is set to 'Ask Caller' mode, it must still verify whether the caller is calling from a fax machine. If the caller reacts positively, by for example pressing 1 on his telephone keypad, the system message 'Press start on your fax' will follow. If the caller reacts negatively, by for example pressing 2 on his telephone keypad, the system message 'Enter your fax number' will follow. This means that the system will use the 'Call back' mode.��Example content�"Are you calling from a fax? Press 1 for yes. Press 2 for no."��System Message�Press start on your fax��Sound File Name:�START.PCM��When used:�When the system is set to the 'Fax back on current connection', or to 'Ask caller' fax reply mode and the caller has chosen the 'Fax back on current connection' method by answering positively to the system message 'Are you calling from a fax', it must instruct him to press the Start button on his own machine so as to immediately receive the documents he requested.��Example content�"The fax documents you have requested are about to be transmitted. Please press the Start button on your fax machine."��System Message�Fax will be sent after your call��Sound File Name:�CALLBAK.PCM��When used:�When the system is set to 'Call back', or to the 'Ask caller' fax reply mode and the caller has chosen the 'Call back' method by answering negatively to the system message 'Are you calling from a fax', the system informs the caller that he will be faxed the requested documentation after hanging up.��Example content:�"The information you have requested will be faxed back as soon as the line is disconnected.".��System Message�Enter your fax number��Sound File Name:�ENTER.PCM��When used:�When the system is set to 'Call back', or to '' fax reply mode and the caller has chosen the 'Call back' method by answering negatively to the system message 'Are you calling from a fax', it must ask the caller to enter his fax number. The system message 'You have entered' will follow.��Example content:�"Please enter your fax number by pressing the digits on your telephone keypad, followed by the pound key."��System Message�You have entered��Sound File Name:�STRING.PCM��When used:�This system message follows after the caller has entered his fax number. The system uses this message and also a combination of number sound files to repeat the fax number to the caller.��Example content:�"You have entered"��System Message�Is this fax number correct��Sound File Name:�NUMCHK.PCM��When used:�This follows the 'You have entered' sequence of system messages in order to verify whether the number is correct. If the caller enters a wrong number, he will be able to re enter it.��Example content:"�Is this number correct? Press '1' for yes or '2' for no."��System Message�This number is blocked��Sound File Name:�BLOCK.PCM��When used:�This system message is directly related to the Fax setting 'Block numbers'. When the caller enters a fax number which you would have previously blocked, he will hear this message and will have an opportunity to enter another number.��Example content:�"This number is either blocked or not authorised. Please re-enter your number followed by the pound key."��System Message�Time expired��Sound File Name:�TIMEOUT.PCM��When used:�You can set a maximum amount of time a caller can be present in the system. When this time is reached, this file is played and the caller is disconnected.��Example content:�"Your allocated time in the system has expired"��System Message�Would you like to select more faxes?��Sound File Name:�MORE.PCM��When used:�This system message is played when the caller has selected a fax, after which he is asked whether he wishes to select another fax.��Example content:�"Would you like to select more faxes, press 1 for yes, 2 for no."��System Message�Goodbye��Sound File Name:�GOODBYE.PCM��When used:�This system message is automatically played back before disconnecting a caller.��Example content:�"Good bye and thank you for using our Fax on demand system��System Message:�Please enter your selection��Sound File Name:�RETRY.PCM��When used:�The caller must react in a certain number of seconds, normally 3 seconds, otherwise this prompt is played to give him another chance.��Example content:�"Please enter your selection, or press 0 for a list of choices."��System Message�Choice not defined��Sound File Name:�NOTDEF.PCM��When used:�The caller entered a wrong digit on his telephone pad��Example content:�"You have entered a wrong digit on your phone keypad. Please choose again or press 0 for a list of choices."���Sending Faxes

Introduction to Faxmaker client software



Using Faxmaker is also environmentally friendly, because you save on paper and toner ink.� \definition "Faxmaker" ��Faxmaker allows you to send and receive faxes from your PC, without having to print the document first, walk to the fax machine, key in the fax number and reschedule at a later stage if the number is busy.

Instead, Faxmaker uses a FAX server computer, located on your network, which is assigned all Fax related jobs, and also allows you to send and receive faxes at the same time!��The benefits

You no longer need to print out a document prior to faxing it.

Faxmaker will automatically retry fax numbers if they are busy.

Your faxes are more legible and of a better quality, since they are sent directly from your PC, using high resolution techniques.

Incoming faxes can be automatically routed to you as soon as they are received.

Only you can view� XE "View" � your outgoing and incoming faxes.

You can easily send faxes to groups� XE "Groups" �� XE "Groups" � of people. 

Ways to send a fax

There are several ways to send a fax with Faxmaker:

1.  Create or open a document in any windows application and print it with the Faxmaker printer driver. This automatically activates the Send Fax window from which you can send the fax.

2.  Start Faxmaker from the Faxmaker program group to send a cover page� XE "cover page" �� XE "cover page" � or fax a document that has already been saved to fax or text format.

3. Send a fax by printing the document to a network print queue� XE "print queue" � (Consult network administrator� XE "administrator" �)

4. Send a fax from an e-mail package (Consult network administrator) 

To help you get started, this chapter takes you through sending and receiving a fax. 

Sending a Fax from an Application

Sending a fax from a Windows application is a simple process in which you make a document in your word processor or any Windows application, and then fax it using Faxmaker's printer driver. If you can print the document in Windows, you will be able to fax it with Faxmaker. Follow the steps outlined in this section to fax your registration form to GFI Fax & Voice:

1.  Start Write/Wordpad.

a.  � XE "Register" �Open the file register.wri� XE "Register" � located in the faxmaker\program group.

(For registering purposes you can use the Write/Wordpad application, but you can use any other Windows application to make your fax documents.)

2.  Fill in the registration form

a.  Type in your particulars on the dotted lines. Please do not forget to fill in your serial number.

3.  Choose the Faxmaker printer driver as your current printer. The Faxmaker printer driver is a mechanism which stores your document as a fax file. 

a.  From Write's 'File' menu, choose 'Printer Setup'. Select the Faxmaker printer driver and choose 'OK'.

�

Selected Faxmaker printer driver

4.   Print your registration form.

a.  From Write's 'File' menu, choose 'Print'. In the 'Print' dialog box, click on 'OK'. 

b.  Immediately after the printer driver has printed your document, Faxmaker starts with the 'Send Fax' window on screen. 

5.  In the 'Send Fax' window, enter the name of the recipient so Faxmaker can search for the fax number. Type in ‘GFI’ in the company field and click search.

6.  GFI's fax number and details now appear in the recipient list box. 

If you do not know the exact name of your recipient, switch to the recipients dialog by clicking the recipients tab. Enter the letter the name starts with. Faxmaker will load the phonebook� XE "Phonebook" � and list all names/companies beginning with that letter. You can select your recipient by clicking ‘Select’. For more detailed information on the recipients dialog, refer to the Recipients section in this chapter.

You can also add a new Recipient directly from the 'Send Fax' window to your default Phonebook.� XE "Default phonebook" �� XE "Default phonebook" � Type in the Recipient's details in the appropriate Recipient fields and click on the 'To Phonebook' button. 

a.  If you want to add a cover page� XE "cover page" \r "D2HBcover_page73" �� XE "cover page" \r "D2HBcover_page63" � to this fax, click on the 'Send CoverPage' button. (See Sending a cover page in this chapter)

b.  If you want to add an attachment to your fax, click on the 'Attach' button and select your fax document from the 'Attachments'� XE "attachments" �� XE "attachments" � window. (See "Advanced fax options" in the next section for further details.) To exclude a previously attached fax file, first select it in the 'Attachments' box in the 'Send Fax' window and then click on the 'Detach' button.

c.  If you want to schedule your fax transmission to a later date or time, click the 'Schedule' button and type the date and time you want your fax to be sent. You must still click on the 'Send' button. Faxmaker will be responsible for sending it off at the time you specified.

d.  If you want to preview� XE "Preview" �� XE "Preview" � your fax, click on the Preview button. Faxmaker will  then convert the fax and activate the viewer. 

e. The ‘Hold to acknowledge’ option also allows you to preview a fax, however the fax is converted on the fax server, and the fax is sent only after you acknowledge the fax via the Fax manager,� XE "Fax Manager" � using the acknowledge function in the Event menu.

f.  If you want to send the document in high resolution mode, select the option 'Send in high resolution mode'.

�

Send Fax window

g.  Click on the 'Send' button. 

If you scheduled this event, it will appear as a 'Pending' Fax in the Fax Manager program.

�

Mailbox� XE "Mailbox" � with a pending fax event 

Sending a Cover Page

To add a cover page to your fax or to fax just a cover page:

1.  In the  'Send Fax' window, enter a Recipient for your fax. 

2.  Click on the 'Coverpage' button to fill in the CoverPage text. You can import� XE "Import" �� XE "Import" � or save text using the open and save buttons. You can also copy and paste text to and from the Coverpage text box, using the windows Copy and Paste shortcut keys

�

The coverpage dialog 

When you want to use a template other than your default template, you can select another one from the list box. �If you are sending a cover page for the first time, be sure to have your personal settings filled in (This can be done from the Fax manager� XE "Fax Manager" � Options menu), so that Faxmaker can fill in sender information into the cover page.

3.  To include the cover page with your fax, activate the ‘Send cover page’ checkbox in the Sendfax window. ��b.  To complete faxing, follow the same procedure as explained in 'Sending a fax from an application' .

Recipients

When you do not know the exact name or company of the recipient, or if you know that there are multiple records for a particular recipient name, you can switch to the recipient dialog, by clicking the recipient button. 

This dialog allows you to search for recipients. You can search for records easily by entering the first letter of the name/company.

�

The recipients dialog

Faxmaker will then list all records starting with those letters. For example to find a name starting with n, simply type in <n>.

After the search you can add one or more recipients by highlighting them with your mouse and clicking ‘Select’. Faxmaker will then add the records to the recipients of the fax.

You can sort and display by company or by name by selecting between Company or Name using the radio buttons.

You can toggle between groups view and individuals� XE "Individuals" � view. (See the Phonebook� XE "Phonebook" � chapter for more information on groups.)

You can switch between phonebooks using the listbox located at the bottom of the dialog.

Advanced Fax options

Advanced fax options are located in the ‘Advanced’ button in the send fax window.

�

The advanced dialog

� XE "Fax Attachment" �Creating a Fax Attachment

Attachments� XE "attachments" \r "D2HBattachments77" �� XE "attachments" \r "D2HBattachments66" � can be handy to store frequently faxed information such as product brochures. These can be graphics intensive, so it makes sense to convert them only once to fax format and store them as fax attachments.

1.  Start the application in which the document is saved.

a.  From that application's menu, choose 'Print Setup'

b.  Select the Faxmaker printer driver and click OK. The Faxmaker send fax window will pop up.� XE "Pop up" �

c. Go to the Advanced dialog by clicking the Advanced button. At the bottom of the dialog you will see your fax attachment  Besides this you will see a button ‘Create attachment’. Click this button.

d. You will be prompted for a file name. Store the file in the Faxmaker/client/fax directory if you wish to share the attachment with other Faxmaker users. The fax will automatically be included in your attachment list, so that you can include it with your next fax.

e. You can either choose to send this attachment immediately, or cancel the send fax process and return to the application.

Sending Attachments

a. After having entered a recipient for the fax, attach a fax file by clicking on the 'Attach button' . The 'Attachments' window is automatically activated, which lists both personal and network attachments. You can toggle between personal and network by selecting the appropriate radio button.

b.  At any time, you can add or remove attachments from this list by selecting the fax file and then clicking the 'Remove' button, or by clicking the add button and selecting a file.

d.  You can also preview� XE "Preview" �� XE "Preview" � an attachment by first selecting it and then clicking on the 'Preview' button. 

e.  To include an attachment with your fax, select a file in this window and click on 'Attach'. You will automatically return to the 'Send Fax' window.

�

Attachments window

The rest of the procedure is identical to that of sending a fax from an application. 

� XE "print queue" �Sending a fax via the print queue

This method allows you to send a fax directly from your application, without having to fill in the fax number in the Sendfax window. This method can be handy if you already have the fax number in your document, and do not want to retype it.

However, in order to use it your network administrator� XE "administrator" \r "D2HBadministrato78" � must install a separate print queue on your network, and configure your word processor to be able to print to it. Usually your administrator will install an additional HP Laserjet printer on LPT 3, and by toggling the printer to LPT 3, you will be able to send a fax. (Consult your network administrator, for more detailed information, or check the Faxmaker installation manual)

To fax a document:

1. Create your document as you normally would in your favourite word processor or database application.

2.  After finishing the document, include the recipient's fax number between the @$ signs at the top of your document, for example,

 @$0181,500200$

The above example will cause this document to be sent to the fax number 0181-500 200.

3.  Toggle the printer to the Fax printer (for example LPT 3), and print the document. 

4. The fax will now be picked up by the fax server, from where it will be sent to the fax number you specified. If the administrator has switched on notification, you will be notified when the fax has been sent or if it has failed.

Sending a fax from an e-mail application

Faxes can be sent from your e-mail package too, providing this feature has been installed by your network administrator.

To send a fax, simply create a new mail message, type in the text you wish to send, and enter the fax number and optionally the name and company (separated by colons) on the top line of the message. For example;

�

Creating a fax in MS Exchange

Address the message to the Faxserver user. The message will be picked up by the fax server, converted to fax and sent out. You will receive notification from the fax server when the fax has been sent.

For more information on how to create a mail message, please refer to the documentation of your e-mail program.

Receiving a Fax

The type of message you receive depends on the installation of Faxmaker. Consult your administrator for more information.� \definition "message box" ��When you receive a fax, Faxmaker will notify you of the new fax using a message box. 

The new fax will be logged in your inbox as an unread fax (Displays the 'Unread' icon under 'Status'). ��Depending on your installation the fax can either be viewed from the Fax manager,� XE "Fax Manager" � or from the E-Mail program which you use, such as MS Exchange or Novell� XE "Novell" � Groupwise. If you are not sure which program to start, please consult your administrator.

The procedure to follow when you receive a fax in the Faxmaker inbox:

1. Start the Fax Manager (See next chapter for more detailed information). Click on the unread fax. Unread signifies that the document would not yet have been viewed.

�

An unread fax

2.  Click on the 'View' icon on the Fax manager tool bar or choose 'View' from the 'Event' menu. The Faxmaker Viewer is automatically activated with your fax document on screen. 

a.  You can view multiple page faxes by choosing the 'Next' and 'Previous' functions in the 'Page' menu.

b.  If you want to print out this fax, choose 'Print' from the 'File' menu. 

d.  Choose 'Exit' from the 'File' Menu.

3.  The fax status should now display 'Read'.



�� XE "Fax Manager" \r "D2HBFax_Manager81" �The Fax Manager

Introduction

The Fax Manager allows you to view� XE "View" \r "D2HBView71" � incoming and outgoing faxes from your desk top. Faxes in your mailbox� XE "Mailbox" \r "D2HBMailbox81" �� XE "Mailbox" \r "D2HBMailbox71" � are displayed in either the inbox or the out box. The Manager also provides access to the Phonebook,� XE "Phonebook" � and the Viewer (discussed in separate chapters).

Viewing sent and received faxes

The Fax Manager allows you to view your mailbox, where all incoming and outgoing faxes are stored. Incoming faxes are stored in the inbox, and outgoing faxes are stored in the outbox. 

You can toggle between the inbox and the out box by clicking the inbox or out box icon. Alternatively you can press ctrl - tab to switch between them.

Startup

Start the Fax manager by double clicking on the 'Fax Manager' icon located within the Faxmaker Client group in the Windows Program Manager.

�

Manager icon

Viewing faxes

To select a Fax to view, you can either click on it with the mouse or you can move within an open mailbox by using the 'up' and 'down' arrow keys on your keyboard.

When you have selected the appropriate fax, click on the view button on the icon toolbar, or select view from the event menu.

Deleting faxes

To delete a fax:

1.  Select the fax and click on the 'Delete' icon.

2.  A message window containing the text 'Are you sure you want to delete this event?' will appear. Click on the 'Yes' button to delete the fax. 

Resubmitting a fax

At times, it could happen that you need to send a fax again, because the fax failed. In this case, all you need to do is select Resubmit� XE "Resubmit" \r "D2HBResubmit82" � from the event menu or icon toolbar and press send.

Saving a Fax

All Incoming faxes are automatically saved in your Faxmaker mailbox. To save the fax as a separate file;

1.  Click on view, and save the fax by choosing the 'Save As' function in the Viewer.

OR

2.  Save the file as an attachment, by choosing the 'Attachments'� XE "attachments" \r "D2HBattachments82" �� XE "attachments" \r "D2HBattachments72" � function from the 'Event' menu. 

OR

3.  You can archive� XE "Archive" �� XE "Archive" � the fax entry and save the attached file with it. (See 'Archiving' further on in this chapter.) 

Printing a Fax

To print a fax:

1.  Select the fax and choose the 'Print' function from the 'Event' menu (or click on the 'Print' icon). If you want to select a printer other than the current default, click on the 'Setup' button and select a particular printer.

2.  Set the Print range and number of copies in the 'Print' window and click on 'OK' to start printing.

Routing faxes

Routing a fax

When you route� XE "Route" �� XE "Route" \r "D2HBRoute72" � a fax or a message, you are in effect moving that event from your own mailbox to that of a colleague/s on your network. You can only route incoming faxes. To route faxes externally (to another fax number), use the 'Resubmit' function in the 'Event' menu.

It is important to remember that when you route a fax or message, you are moving that event from your mailbox to that of your colleague/s. If you only want to copy an event to a colleague's mailbox, choose the 'Forward' function from the 'Event' menu. The procedure to follow when forwarding an event is identical to the routing procedure.

To route a fax:

1.  Click on the fax you want to route to select it.

2.  Choose 'Route' from the 'Event' menu. This function activates the 'Route' window. The 'Recipients' box lists the people connected to your network.

�

Route window

3.  Select the person to whom you want to route the event and click on the 'Add' button. (When you want to route the same event to a number of people, repeat this procedure for every recipient.)

4.  The selected recipient/s will then appear in the list box directly beneath. To exclude a previously selected person, click on the 'Remove' button.

5.  In the 'Attachments' list box, the name of the event you previously selected from your mail box is displayed. You can attach other files by clicking on the 'Attach' button. This activates a dialog box from which you can select your file. To exclude a previously attached file, select it by clicking on it in the 'Attachments' box and then clicking on the 'Remove' button. These files can be of any file format.

6.  To attach a message to the event you are routing, click on the 'Message' button, and the message window is displayed. Type in your message and click on 'OK'.

7.  When your recipient/s are selected, click on the 'Send' button to route the event.

� XE "Inbound" �� XE "Inbound router dialog" �� XE "Inbound" �� XE "Inbound router dialog" �Inbound routing

If you are the inbound router and need to route� XE "Route" � incoming faxes to the appropriate recipient, you can use the inbound router dialog, which allows you to route multiple faxes. To use the inbound router dialog, you must have been assigned the rights to access the default mailbox� XE "default mailbox'" � by your administrator.� XE "administrator" � 

�

Inbound router dialog

To activate the Inbound Router dialog, click the Inbound Router icon on the toolbar or select ‘Inbound Routing’ from the Options menu.

A dialog will appear, where you can select one or more faxes to route and one or more users to route to. Clicking the Route button will route the highlighted fax(es) to the highlighted user(s), making a copy of each fax if you have selected multiple users. You can continue routing faxes until the fax window is empty, in which case there are no more faxes in the default mailbox to route. 

The option ‘Store CSID� XE "CSID" � for routing’ will cause Faxmaker to store the CSID - the fax sender identification - in a database, so that next time a fax from this sender arrives, it will be automatically routed to the recipient you specified. This reduces the routing burden for future faxes.

To exit the window click the Close button.

� XE "Logs" \r "D2HBLogs84" �� XE "Logs" \r "D2HBLogs74" �Logs

Customising Logs

You can configure your mailbox to have different views by specifying filters in the 'Settings' window. These are called Logs. The Inbox and Out box are also Logs with filters set to incoming and outgoing.

Arranging Logs on Screen

When you have more than one open Log in your Manager work space, you can arrange the way they are displayed by first selecting the 'Windows' menu and then the 'Cascade', 'Tile' or 'Arrange Icons' command. 

Creating new Logs

By creating new Logs, you can display as much information as you want in as many ways as you want it. 

To add a new Log:

1.  In the Fax Manager,� XE "Fax Manager" � choose 'Open Mailbox' from the 'Log' menu. Select the mailbox and click OK. The mailbox is displayed on your screen. 

2.  To redefine the filters for this mailbox, choose 'Settings' from the 'Log' menu. 

a.  In the 'Log Settings' dialog box, in the field marked 'Window Title', type in the name of your Log depending on the filters you are about to apply. For example, if your mailbox is defined to display outgoing events, you could call it 'OutLog'.

b.  In the section marked 'View� XE "View" � Events' you can select one of the options; 'All', 'Incoming', 'Outgoing', 'Unread incoming', and 'Pending Outgoing'. 

3.  Click on 'OK' to register� XE "Register" �� XE "Register" \r "D2HBRegister75" � the new filters for this mailbox.

Printing Logs

To print a selected Log:

1.  Choose 'Print Log' from the 'Log' menu. The windows Notepad application is automatically activated and contains a text transcript of all the Mail entries present in that Log.

2.  Choose 'Print' from the 'File' menu in Notepad.. 

Archiving Faxes

If you want to archive� XE "Archive" \r "D2HBArchive85" � your faxes, you can choose one of two options. You can either delete obsolete faxes or you could archive� XE "Archive" \r "D2HBArchive75" � them. It is of utmost importance that you archive or delete faxes periodically for disc space� XE "disc space" � reasons.

To archive faxes you must first select the faxes you want to archive. For instance, if you are going to archive all sent faxes, you could first group them in a Log by choosing the 'Outgoing' filter in the 'Log Settings' window and archive the whole Log. Alternatively, you could use your 'Shift' key, to select consecutive faxes and then archive the selected Mail only. You can either make a new file for every archive, or you could add subsequent faxes to a particular archive mailbox. 

Archiving mail for the first time

1.  Choose 'Archive' from the 'Event' menu. 

2.  In the 'Archive' window, click on the 'New' button. 

a.  In the 'New Archive' dialog box, choose the directory you want to place your file in and type in a name for it. Click on 'OK'. This file should be now displayed in the 'Archive file name' list box.

b.  If you want to save all the faxes in the selected Log, choose the option 'Save all events in log'. Alternatively, if you only want to save the faxes you previously selected, choose the option 'Save selected events only'.

�

Archive window

c.  If you want to remove this archived fax from your Default Mailbox,� XE "default mailbox'" � click on the 'Delete archived events in mailbox log' check box. However, if, for instance, you are only making a backup for your Logs, you should leave this option un selected.

d.  To save all attached fax files, click on the 'Save attachments'� XE "attachments" �� XE "attachments" � check box.

e.  Click on 'OK'.

The archive mailbox, displaying the file name and archived logs, appears in your Manager workspace.

Adding faxes to an existing archive

To add faxes to an existing archive mailbox: 

1.  Select the faxes you want to archive.

2.  Choose 'Archive' from the 'Event' menu.

3.  In the 'Archive' window, choose the 'Open' button and select your existing archive file from the 'Open Archive' dialog box.

4.  Follow the procedure outlined in the previous section 'Archiving faxes for the first time', steps 2b to e.

Opening an archive mailbox

To open an archive mailbox:

1.  Choose 'Open Archive' from the 'Log' menu. This function activates the 'Open Archive' window. 

2.  Click on the 'Open' button to browse through the 'Open Archive' dialog box until you find a previously archived mailbox. Archived mailboxes carry the '*.arc' extension. 

3.  Click on 'OK' to register� XE "Register" � your choice and return to the 'Open Archive' window. The file name and path should now be displayed. 

You can view� XE "View" � and print archived faxes in the standard manner.� \definition "archive mailbox" ��4.  Click on 'OK' to return to the main Manager window. The archive mailbox, displaying the file name and archived faxes, appears in your Manager workspace.��Personal Settings

It is important that you fill in the personal settings since they are used when creating a cover page.� XE "cover page" �� XE "cover page" �

1.  Choose 'Personal Settings' from the 'Options' menu. This activates the 'Personal Settings' window

2.  Type in your particulars including phone, fax and if available, data number. This information is transferred to your fax cover pages.

3.  Select the option 'Message Notification' for Faxmaker to notify you every time new mail is deposited in your mailbox.

�� XE "Phonebook" \r "D2HBPhonebook89" �The Phonebook

Introduction

One of the most useful features of computer based faxing is that, using a phonebook, you do not need to re-key the fax number each time you send a fax. By typing the name of the recipient in the send fax window, the fax number is automatically found.

The phonebook enables you to store and manage lists of recipients and their particulars. Each person in the phonebook is called a Record. You can add an unlimited amount of records to your phonebook, and you can group recipients together using the group function. You can import� XE "Import" �� XE "Import" � and export� XE "Export" �� XE "Export" � data easily to and from the Phonebook.

To start the Phonebook, click on the 'Phonebook' icon located on the Fax manager� XE "Fax Manager" � tool bar or choose 'Phonebook' from the 'Window' menu.

Managing Individual recipients

� XE "Adding records" �� XE "Adding records" �Adding records

When you are in 'Individuals'� XE "Individuals" �� XE "Individuals" � view,� XE "View" � the 'Groups'� XE "Groups" �� XE "Groups" � button is displayed at the bottom of the Phonebook window. Alternatively, when you are in 'Groups' view, the 'Individuals' button is displayed.� \definition "'Individuals' view" ��When you want to add a Record, you must always have an open phonebook and be in the 'Individuals' view. (Check this by opening the 'View' menu. The 'Individuals' function should have a check mark alongside.) 

When you have more than one phonebook in your default list, you must first select the phone-book to which you want to add your Record by selecting it from the list box on your icon tool bar.

To add a Record:��1.  Select the phonebook to which you are going to add a Record by clicking on it.

2.  Click on the 'Add Record' icon or choose 'Add' from the 'Record' menu

�

Add record window

3.  In the 'Add Record' dialog box, type in that person's particulars 

4.  When you type in phone, fax or data numbers, make sure you type in the complete number including country entry codes for overseas faxing. These should be followed by an appropriate separator, such as a comma (,). Please consult your fax modem manual for accepted pause separators. 

5.  Click on 'OK' to register� XE "Register" �� XE "Register" � your new Record.

The new Record should now be displayed with rest of the other Records in the main Phonebook window. 

Finding Records

You can search for records, both from the Phonebook itself or from the 'Send Fax' window.

1.  You can search for a record in the Phonebook by choosing 'Find' from the 'Search' menu.

a.  In the 'Find Record' window type in some details of the recipient you want to trace (company/contact name or country etc.) and then press 'Enter'. 

b.  Faxmaker will search the currently open Phonebook and display the record which matches your specifications. Should this be the incorrect record, either choose 'Find again' from the 'Search' menu to flip through other matching records until you find the right one. You could also add more information in the 'Find Record' window and choose 'Find Record' again from the 'Search' menu.

Or

2.  In the 'Send Fax' window, you can search for a record without opening the Phonebook. Type in the recipient/company name in the 'Recipient' fields and then click on the 'Search' button. Faxmaker will search your default Phonebook� XE "Default phonebook" �� XE "Default phonebook" �  for the recipient's details which it will display in the appropriate Recipient field in the 'Send fax' window.

Sorting Records

You can sort records alphabetically, either according to 'Lastname' or to 'Company'. Simply select one of these options in the main Phonebook window and Faxmaker will immediately sort the records in that phonebook.

Deleting Records

To delete a Record:

1. From a particular phonebook file, select a Record by clicking on it. If you want to delete more than one Record, hold down the 'Shift' key whilst clicking with the mouse.

2.  Click on the 'Delete' icon or choose 'Delete' from the 'Record' menu

3.  Click on the 'Yes' button to the message 'Are you sure you want to delete this entry'.

Groups

Groups are collections of individual Records. Groups can be used to create fax broadcasts to a group of people.

Adding Groups

When you want to add a Group, you must always have an open phonebook containing individual Records and be currently in 'Groups' view.� XE "View" \r "D2HBView81" � (Check this by opening the 'View' menu. The 'Groups' function should have a check mark alongside.) To add a Group:

1.  In a particular phonebook file, switch to 'Groups' view by clicking on the 'Groups' button.

2.  Click on the 'Add Group' icon or choose 'Add' from the 'Group' menu 

�

Adding records� XE "Adding records" �� XE "Adding records" � in the Groups window 

3.  In the 'Group name' window, type in a name for this Group.

4.  Click on 'OK' to register� XE "Register" �� XE "Register" � your Group name.

5.  The 'Groups' window is activated. The left hand side of this window contains the particulars of the individual Records found in that phonebook file. The right hand side, contains the names of Groups found in that phonebook file, and the individual Records they contain. You can add and/or remove individuals� XE "Individuals" �� XE "Individuals" � from Groups by first selecting them and clicking on the arrow button. 

Deleting Groups

To delete a Group:

1.  In 'Groups' view select the Group by clicking on it. If you want to delete more than one, hold down the 'Shift' key whilst selecting them with the mouse.

2.  Click on the 'Delete' icon or choose 'Delete' from the 'Group' menu

3.  Click on the 'Yes' button to the message 'Are you sure you want to delete this Group'. 

Phonebooks

Upon installation, two phonebooks are created; One personal phonebook, accessible only to yourself, and a corporate phonebook, stored in a shared directory and accessible to everyone using Faxmaker.

If you plan to use large groups or lists of people, you might want to make separate phonebooks.

Making a new Phonebook

Faxmaker can have any number of phonebook files ('*.phb'). 

To make a new Phonebook:

1.  Choose 'New' from the 'File' menu.

2.  In the 'New Phonebook' dialog box, under the 'File Name' field, type a file name. To create a shared phonebook, save the file to the Faxmaker/client/phonebk directory. 

Adding to the Phonebook List

If you have just created a new Phonebook, you will see that particular phonebook name displayed in the title bar. However, this name will not appear in the list box in the send fax window, until you first define it in the 'Phonebook list'. Consequently, every time you open the Phone-book, you will be able to access that particular phonebook file from this drop-down list box in both the send fax window and the phonebook.

1.  Choose 'Phonebook list' from the 'Options' menu. 

�

Phonebook list window

2.  Click on the 'Add' button. In the 'Select Phonebook' dialog box, select the phonebook file and then click on 'OK'.

3.  In the 'Edit Description' box, type in a name. The 'Edit Description' function allows you to assign a more descriptive name for your phonebook by enabling both upper and lower case characters and also spacing in between letters (as opposed to the standard Windows 8 character file name). 

4.  Click on 'OK' to return to the 'Phonebook list' window. 

5.  Click on the 'Set Default' button and then on 'OK' to automatically open this file every time you start the Phonebook.

Removing from the Phonebook List.

If you do not want a particular phonebook to appear in the drop-down 'Phonebook list', you can simply remove it. This does not mean that you are deleting the actual phonebook but just removing from the Phonebook's list. To remove a phone book file from the 'Phonebook list':

1.  Choose 'Phonebook list' from the 'Options' menu.

2.  Select the file you want to remove by clicking on it and then on the 'Remove' button.

3.  Click on 'OK'.

Deleting Phonebooks

Phonebooks are ordinary files. You can delete them in the windows File Manager as you would any other file, by choosing 'Delete' from the 'File' menu. Phonebook files carry the '*.phb' extension.

Saving Phonebooks

You do not need to save phonebook files. Whenever you add, delete or edit Records or Groups within a particular phonebook file, the adjustments are saved automatically. However, you can save existing files under a different name and/or directory by choosing the 'Save As' function.

Exporting Phonebooks

You can export� XE "Export" � Faxmaker phonebooks to dbf and ascii file formats.In effect, this means that you can export to any application supporting Dbase or ASCII file formats. 

1.  Select the Records you want to export. When you want to select more than one Record, hold down the 'Shift' key whilst clicking on the Records with the mouse.

2.  Choose 'Export Dbase' (or 'ASCII') from the 'File' menu.

3.  In the 'Export to Dbase (or 'ASCII') File' dialog box, select the directory which will contain the new database file. Type in a file name with either the '*.txt' or the '*.dbf' extension (depending on which application you want to export to) and click on 'OK'.

4.  In the 'Export Records' window, which is automatically activated, you will have to pick fields from the 'Available fields' list box and connect them to the 'Selected fields' list box by clicking on the arrow button directed to the right.

�

Export Records window

5.  You can either choose the 'Add All' button to export all the available fields (or conversely, choose the 'Remove All' button to exclude all the previously selected fields). If you want to export a few fields only, simply click on one particular field in the 'Available fields' list box, then click on the Arrow button directed to the right. Repeat this procedure for every field you want to export. If you make a mistake by including the wrong field, select it and click on the 'Arrow' button directed to the left to remove it.

6.  Click on 'OK'.

7.  Start the destination application and open or import� XE "Import" \r "D2HBImport94" � the file which you have just created. If this application can directly open '*.txt', ASCII or '*.dbf' files, you can open the file directly. If not consult that particular application's manual on import procedures. 

Importing DBase or ASCII files

To illustrate the procedure of importing Records from another application, follow the subsequent procedure. You can import Dbase III, IV or ASCII files.

1.  In a particular phonebook� XE "Phonebook" � file, choose 'Import Dbase' (or 'ASCII') from the 'File' menu.

2.  In the 'Import from Dbase (or 'ASCII') File' dialog box, select the directory which contains the database file you want to import. Choose the file and click on 'OK'.

3.  In the 'Choose Import Fields' window, which is automatically activated, you will have to connect 'Source fields' with the destination fields, called 'Phonebook fields'.

4.  You simply click on one particular field in the 'Source field' list box, then click on its corresponding field in the 'Phonebook field' and link them by clicking on the 'Connect' button. This is done for every field, but you can leave out those fields which in your case are unnecessary. If you make a mistake by connecting the wrong 'Phonebook field' to a particular 'Source field' (or vice-versa), click on the 'Disconnect' button to cancel your previous action.

�

Import Records window

Before actually connecting 'Source fields' to 'Phonebook fields', we would recommend that you first have a look at your source application and the field names it uses. Use the ‘flocalnum’ as your fax number field.

5.  Click on 'OK' and wait a few seconds until the Phonebook processes the new Records. The imported Records will be then displayed in the main Phonebook window.

6.  Unless you want to save the Phonebook with a different name, the new Records will be automatically saved as part of the currently open phonebook. 

�The Viewer

Introduction

With the Faxmaker Viewer, you can view,� XE "View" \r "D2HBView87" � print and save fax files. 

This chapter will deal with the following topics:

Start Up

Viewing Faxes

Start Up

The Faxmaker Viewer can be activated in several ways:

1.  By double clicking on the 'Viewer' icon in the Faxmaker group.

�

Faxmaker Viewer icon

2.  When you are in the Fax Manager� XE "Fax Manager" � program, you can select a fax mail and click on the 'View' icon located on your tool bar (or choose 'View' from the 'Event' menu) and the Viewer application is activated with that particular fax on screen. You can also choose 'Viewer' from the 'Window' menu.

�Viewing Faxes

The viewer is used to:

1.  View incoming or outgoing faxes,  by clicking on the fax in the Manager and then choosing 'View' from the 'Event' menu (or clicking on the 'View' icon). The Faxmaker Viewer is automatically activated and displays that particular fax on screen.

2.  To preview� XE "Preview" � outgoing faxes, by clicking the ‘Preview’ button in the 'Send Fax' window. The Faxmaker Viewer is automatically activated as soon as the fax has been converted. 

In the Viewer itself you can:

a.  Preview pages one by one, using the 'Next' or 'Previous' command from the 'Page' menu. When your document is made up of one page, these functions will be dimmed.

b.  Re-size the document on your screen by choosing either the 'Horizontal Fit' or the 'Vertical Fit' from the 'View' menu.

c.  Zoom in or out whilst viewing the document from a number of viewpoints by choosing an appropriate zoom value from the 'View' menu. 

d.  Invert the image by choosing the Invert command from the 'View' menu.

e.  Print the document to your local printer by choosing the 'Print' command from the 'File' menu.

f . Save the fax on your hard disk. Choose the 'Save as' function from the 'File' menu (or click on the 'Save as' icon) and type the file name in the 'Save as' dialog. You can save documents in '*.fax', '*.tiff' or '*.dcx' file format. Choose 'Exit' from the 'File' menu.

�� XE "OS/2" \r "D2HBOS_299" �� XE "Fax Manager" \r "D2HBFax_Manager99" �� XE "DOS" \r "D2HBDOS99" �� XE "OS/2" \r "D2HBOS_289" �� XE "DOS" \r "D2HBDOS89" �DOS / OS/2 Fax manager

Introduction

Faxmaker for networks includes a character based client for DOS & OS/2. This means that all network users can utilise and have access to Faxmaker regardless of the platform they use. The interface of the Windows & DOS Fax manager is similar, which means that most procedures to follow when using DOS have already been described in detail within the rest of this manual. All program and configuration files are compatible and interchangeable (phonebook,� XE "Phonebook" � fax and message files). To install this program, please refer to the Installation section. 

Start Up

To start the Faxmaker program in DOS;

1.  If Faxmaker was installed in the path, type  <Faxmaker> . 

2. Faxmaker will start and prompt you to type in your user name and password.� XE "Password" �� XE "Password" � 

If you installed the DOS Fax manager under OS/2, you probably created a desktop icon for it. Double-click the icon to start it and enter your user name and password.

Viewing sent & received faxes

The DOS fax manager allows you to view incoming and outgoing faxes, from where you can view, print or route� XE "Route" �� XE "Route" � faxes. Just as in the windows version all mail is routed to your personal mailbox,� XE "Mailbox" �� XE "Mailbox" � which can be viewed in two ways - Incoming faxes (Receive log) and outgoing faxes (Send Log). These logs� XE "Logs" �� XE "Logs" � must be activated by opening them from the log menu. You can toggle between the 'Send' and 'Receive' logs by either clicking on a particular window to make it active, or by choosing the 'Send' or 'Receive' options within the 'Log' menu. Should you want to print your logs, you must do this from Windows. 

Viewing a fax

To view a sent or received fax:

1.  Select a fax in the log and choose 'View' from the 'Event' menu. Alternatively you can press Alt - V on the keyboard.

a.  The viewer will start up. To zoom in or out, press the + or - signs on your keyboard. To move up and down the page, use the up and down cursors. To change to the previous or next page, use the Page down and Page up keys. 

b.  When you have finished viewing the fax, you may exit the Viewer, by pressing 'Esc'.

c. You are automatically returned to the Fax manager.

Printing a fax

To print a sent or received fax:

1.  Select a fax in the log and choose 'Print’ from the 'Event' menu. Alternatively you can press Alt - P on the keyboard.

Note; To print faxes from DOS, you need to have an HP Deskjet or HP  Laserjet compatible printer

Sending Faxes from DOS or OS/2

There are two ways to send a fax from DOS;

1.  Using embedded codes� XE "embedded codes" \r "D2HBembedded_cod100" � 

2.  Using a TSR (Terminate and Stay Resident).

Using embedded codes

This method allows you to send a fax directly from your application, without having to switch to the Fax manager. However, in order to use it your network administrator� XE "administrator" \r "D2HBadministrato100" � must install a separate print queue� XE "print queue" � on your network, and configure your word processor to be able to print to it. Usually your administrator will install an additional HP Laserjet printer on LPT 3, and by toggling the printer to LPT 3, you will be able to send a fax. (Consult your network administrator, for more detailed information, or check the Faxmaker installation manual)

To fax a document:

1. Create your document as you normally would in your favourite word processor or database application.

2.  After finishing the document, include the recipient's fax number between the @$ signs at the top of your document, for example,

 @$0181,500200$

The above example will cause this document to be sent to the fax number 0181-500 200.

3.  Toggle the printer to the Fax printer (for example LPT 3), and print the document. 

4. The fax will now be picked up the fax server, from where it will be sent to the fax number you specified. If the administrator has switched on notification, you will be notified when the fax has been sent or if it has failed. 

Using a TSR

In DOS, you can use a TSR to send faxes too. This option is not available under OS/2.

1.  Activate the print spooler TSR, called PCL Taker. This program remains resident in the computer's memory, and can store data which is to be faxed. PCLTaker is located in the Faxmaker directory. To activate it just type <PCLTaker>. When it starts, it will tell you the directory where it will spool your files. This directory is set in the 'faxmaker.ini' file.

2.  Start your word processor and open or create a document to be faxed. Remember that under DOS, we can only support a limited number of fonts, namely 'Line Printer' and 'Courier'. (Consult your network administrator if you need more.)

a.  Toggle the print spooler on using the 'Right Shift + P' keys. On doing so, you will hear a beep, which confirms that the print spooler is on.

b.  Issue a print command in your word processor.

c.  A dialog will appear requesting a file name for the fax. The document will be spooled into a designated path. (This is pre- determined by the 'faxmaker.ini')

d.  To resume normal printing on your printer, toggle PCL Taker off, by pressing the 'Right Shift + O' keys again. It will beep twice to notify you that the print spooler is off.

3.  To send a fax, you must exit your word processor and start up Faxmaker. When you start Faxmaker you must instruct it to convert the spooled data (on the same command line).

a.  This is done using the < /c> option followed by <(space)/ filename> to convert a specific fax file. Conversely you can type in </c> followed by <(space)/a>, which will convert all the fax documents in the designated path. Ex.: Faxmaker /c /a

4.  In the Faxmaker program, activate the 'Send Fax' dialog.

a.  Type in your recipient's details and then click on the 'Add' button or choose a recipient from the Phonebook� XE "Phonebook" \r "D2HBPhonebook102" � by first clicking on 'Phonebook' and then selecting a recipient and pressing 'Enter'. To fax to a number of people, you must select each record separately from the Phonebook.

b.  Click on 'Attach' and choose your fax file from the 'Select a File' dialog. Press 'Esc' to return to the dialog and then click on 'OK' to return to the 'Send Fax' window where the fax file should now be listed in the 'Attachments'� XE "attachments" �� XE "attachments" \r "D2HBattachments92" � section. To exclude a previously attached fax file, first select it in the 'Attachments' box and then click on the 'Detach' button.

c.  If you want to add a cover page� XE "cover page" \r "D2HBcover_page102" �� XE "cover page" \r "D2HBcover_page92" � to this fax, click on the 'CoverPage' button and type in your details and/or message. (See 'Sending a cover page')

d.  If you want to schedule your fax transmission to a later date or time, click the 'Schedule button and type the date and time you want your fax to be sent.

e.  If you do not want to save the fax files, select the option 'Delete file(s)'.

f.  When you want to send the document in high resolution mode, select the option 'Send in high resolution mode'.

g.  To preview,� XE "Preview" �� XE "Preview" � select the file and click on the 'Preview' button.

h.  Click on the 'Send' button.



Faxing a cover page

To send a cover page or to include a cover with your fax:

1.  In the Faxmaker 'Send Fax' dialog, click on 'Coverpage'

2.  You can type in Sender and Recipient information and you can import� XE "Import" �� XE "Import" � text for your message text.

3.  Click on 'OK' to include this cover page with your fax.

4. Enter recipient information and send the fax.

The Phonebook

Each user can have two phonebook files, a personal one and a corporate one. These files are compatible with the windows phonebook file formats so that DOS users can also share company data and vice-versa. Whenever the Phonebook is activated, these two files are automatically opened and the user can toggle between them by clicking on the 'Toggle' button. The paths used by the phonebooks used are specified in the 'faxmaker.ini' file. 

�Troubleshooting

Server software problems

“The modem does not dial out.”

In some cases your modem may not dial out, returning the error message “No dial tone”. The problem could be caused by the fact that not all export� XE "Export" � modems recognise the dial tone. To solve this, disable “Wait for Dial Tone” in the Fax setup window of the server.
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